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F
(F
Y  the party responsible for compliance
co

T ass B digital device, pursuant to Part
1 ction against harmful interference in
a dio frequency energy and, if not in-
st terference to radio communications.
H r installation. If this equipment does
ca etermined by turning the equipment
o r more of the following measures:

•
•
• the receiver is connected.
• elp.

O

1

2  cause undesired operation of the 
Preface

CC Statement
ederal Communications Commission)

ou are cautioned that changes or modifications not expressly approved by
uld void the user's authority to operate the equipment.

his equipment has been tested and found to comply with the limits for a Cl
5 of the FCC Rules. These limits are designed to provide reasonable prote
residential installation. This equipment generates, uses and can radiate ra
alled and used in accordance with the instructions, may cause harmful in
owever, there is no guarantee that interference will not occur in a particula
use harmful interference to radio or television reception, which can be d

ff and on, the user is encouraged to try to correct the interference by one o

Re orient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which 
Consult the service representative or an experienced radio/TV technician for h

peration is subject to the following two conditions:

. This device may not cause interference.
And

. This device must accept any interference, including interference that may
device.
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F
1 ny other antenna or transmitter.

2 for an uncontrolled environment. This 
0 centimeters between the radiator 

d that changes or modifications not ex-
ould void your authority to operate the

ropriate antennas will be installed. Note
na must not be co-located or operate in
CC RF Radiation Exposure Statement:
. This Transmitter must not be co-located or operating in conjunction with a

. This equipment complies with FCC RF radiation exposure limits set forth 
equipment should be installed and operated with a minimum distance of 2
and your body.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautione
pressly approved by the manufacturer for compliance with the above standards c
equipment.

If your purchase option includes both Wireless LAN and 3.5G modules, then the app
that In order to comply with FCC RF exposure compliance requirements, the anten
conjunction with any other antenna or transmitter.
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IONS
F risk of fire, electric shock, and injury
to

1 l, kitchen sink or laundry tub, in a wet 

2 pe) during an electrical storm. There 

3
4 pose of batteries in a fire. They may 

.
5  Input of 100 - 240V, 50 - 60Hz, DC 

A  or disassembling this equipment.

T WG OR LARGER, TELE-
D

lass 1 Product
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IMPORTANT SAFETY INSTRUCT
ollow basic safety precautions, including those listed below, to reduce the 
 persons when using any electrical equipment:

. Do not use this product near water, for example near a bath tub, wash bow
basement or near a swimming pool.

. Avoid using this equipment with a telephone line (other than a cordless ty
may be a remote risk of electrical shock from lightning.

. Do not use the telephone to report a gas leak in the vicinity of the leak.

. Use only the power cord and batteries indicated in this manual. Do not dis
explode. Check with local codes for possible special disposal instructions

. This product is intended to be supplied by a Listed Power Unit with an AC
Output of 19V, 4.74A (90 Watts) minimum AC/DC Adapter.

CAUTION
lways disconnect all telephone lines from the wall outlet before servicing

O REDUCE THE RISK OF FIRE, USE ONLY NO. 26 A
COMMUNICATION LINE COR

This Computer’s Optical Device is a Laser C
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In
T  this, follow these suggestions:

1 the components could be damaged.

2  away from any kind of heating ele-
it, the computer could be badly dam-

t place anything heavy 
 computer.

om-
nment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
structions for Care and Operation
he notebook computer is quite rugged, but it can be damaged. To prevent

. Don’t drop it, or expose it to shock. If the computer falls, the case and 

. Keep it dry, and don’t overheat it. Keep the computer and power supply
ment. This is an electrical appliance. If water or any other liquid gets into 
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do no
on the

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the c
puter in a humid enviro
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3 mers, electric motors, and other 
e your data.

4 puter down properly and don’t forget 
 be lost if the battery is depleted.

5

 com- Perform routine maintenance 
on your computer.

 before 
evices.
I
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. Avoid interference. Keep the computer away from high capacity transfor
strong magnetic fields. These can hinder proper performance and damag

. Follow the proper working procedures for the computer. Shut the com
to save your work. Remember to periodically save your data as data may

. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the
puter by yourself.

Use only approved brands of 
peripherals.

Unplug the power cord
attaching peripheral d
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ve access 
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cts 

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
ower Safety
he computer has specific power requirements:

Only use a power adapter approved for use with this computer.
Your AC/DC adapter may be designed for international travel but it still requir
steady, uninterrupted power supply. If you are unsure of your local power spec
consult your service representative or local power company.
The power adapter may have either a 2-prong or a 3-prong grounded plug. The
prong is an important safety feature; do not defeat its purpose. If you do not ha
to a compatible outlet, have a qualified electrician install one.
When you want to unplug the power cord, be sure to disconnect it by the plug 
by its wire.
Make sure the socket and any extension cord(s) you use can support the total c
load of all the connected devices.
Before cleaning the computer, make sure it is disconnected from any external 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy obje
on the power cord.
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B
• lode, leak or damage the computer.
•
•  (e.g. bent or twisted) in any way. Even 

se circuit damage, which may possibly 

• y from the computer for storage.
• make the battery explode.
• t to your service representative or qual-

•  dispose of batteries carefully. Batteries 

•
•
•

s recyclable. At the end of its useful life,
he municipal waste stream. Check with
 disposal.

r equivalent type recommended by the
III
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attery Precautions
Only use batteries designed for this computer. The wrong battery type may exp
Do not remove any batteries from the computer while it is powered on.
Do not continue to use a battery that has been dropped, or that appears damaged
if the computer continues to work with a damaged battery in place, it may cau
result in fire.
If you do not use the battery for an extended period, then remove the batter
Recharge the batteries using the notebook’s system. Incorrect recharging may 
Do not try to repair a battery pack. Refer any battery pack repair or replacemen
ified service personnel.
Keep children away from, and promptly dispose of a damaged battery. Always
may explode or leak if exposed to fire, or improperly handled or discarded.
Keep the battery away from metal appliances.
Affix tape to the battery contacts before disposing of the battery.
Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery i
under various state and local laws, it may be illegal to dispose of this battery into t
your local solid waste officials for details in your area for recycling options or proper

Danger of explosion if battery is incorrectly replaced. Replace only with the same o
manufacturer. Discard used battery according to the manufacturer’s instructions.
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C
D
D of the computer.

S
D ur warranty and expose you and the
co nnel. Unplug the computer from the
p y of the following conditions:

•
•
• tions.
• id if the LCD panel breaks).
•

remember to replace the cover(s) and
leaning
o not apply cleaner directly to the computer; use a soft clean cloth. 
o not use volatile (petroleum distillates) or abrasive cleaners on any part 

ervicing
o not attempt to service the computer yourself. Doing so may violate yo
mputer to electric shock. Refer all servicing to authorized service perso

ower supply. Then refer servicing to qualified service personnel under an

When the power cord or AC/DC adapter is damaged or frayed.
If the computer has been exposed to rain or other liquids.
If the computer does not work normally when you follow the operating instruc
If the computer has been dropped or damaged (do not touch the poisonous liqu
If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, 
screw(s) before turning the computer on.
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T

P
A  is ready to go:

1
2
3
4 . 
5 d a second voltage adapter. However, 

6
7 ck them and those devices’ adapters 

8 quire proof of ownership for both hard-

l bag (or any such container). Putting a
utlet(s) to be blocked. To prevent your

t(s) while the computer is in use.
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ravel Considerations

acking
s you get ready for your trip, run through this list to make sure the system

. Check that the battery pack and any spares are fully charged.

. Power off the computer and peripherals.

. Close the display panel and make sure it’s latched.

. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag

. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t nee
check with your travel agent to see if you need any socket adapters.

. Put the notebook in its carrying bag and secure it with the bag’s straps.

. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pa
and/or cables.

. Anticipate customs - Some jurisdictions may have import restrictions or re
ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a trave
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/o
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outle
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O
In ce, and Chapter 8: Troubleshooting,
k

H  some areas, computer theft is very
co e sufficiently careful. Avoid knock-
in

B -ray machines can damage the com-
p stored data - Pass your computer and
d u may be asked to turn it on). Note:
S

F d other electronic devices in flight.
T k in an overhead compartment, make
su s opened.

G C adapter and keep your battery(ies)
ch

K or can condense inside the computer.
W .
n the Road
 addition to the general safety and maintenance suggestions in this prefa

eep these points in mind:

and-carry the notebook - For security, don’t let it out of your sight. In
mmon. Don’t check it with normal luggage. Baggage handlers may not b
g the computer against hard objects.

eware of Electromagnetic fields - Devices such as metal detectors & X
uter, hard disk, floppy disks, and other media. They may also destroy any 
isks around the devices. Ask security officials to hand-inspect them (yo
ome airports also scan luggage with these devices.

ly safely - Most airlines have regulations about the use of computers an
hese restrictions are for your safety, follow them. If you stow the noteboo
re it’s secure. Contents may shift and/or fall out when the compartment i

et power where you can - If an electrical outlet is available, use the AC/D
arged.

eep it dry - If you move quickly from a cold to a warm location, water vap
ait a few minutes before turning it on so that any moisture can evaporate
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D
D e computer for long periods of time.
Im titive strain to your hands, wrists or
o

he keyboard is at or slightly below the 
nd hands in a relaxed position.
s. Place your feet flat on the floor or on 

ur lower back comfortably.
rm approximately 90-degree angles 

r for long periods of time.

.
ter for long periods of time. Frequent 
reaks.
II
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eveloping Good Work Habits
eveloping good work habits is important if you need to work in front of th
proper work habits can result in discomfort or serious injury from repe

ther joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that t
level of your elbow. Keep your forearms, wrists, a

• Your knees should be slightly higher than your hip
a footrest if necessary.

• Use a chair with a back and adjust it to support yo
• Sit straight so that your knees, hips and elbows fo

when you are working.
• Take periodic breaks if you are using the compute

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day
• Take periodic breaks when you work at the compu

and short breaks are better than fewer and longer b



XIII

Preface

L
P  and muscle fatigue in your neck and
sh

• side sources of light.
•  allow you to see the screen clearly.
•
•

L
T  display of graphics on the screen for
an

• een idle time.
• g displayed too long).
•
•

ighting
roper lighting and comfortable display viewing angle can reduce eye strain
oulders.

Position the display to avoid glare or reflections from overhead lighting or out
Keep the display screen clean and set the brightness and contrast to levels that
Position the display directly in front of you at a comfortable viewing distance.
Adjust the display-viewing angle to find the best position.

CD Screen Care
o prevent image persistence on LCD monitors (caused by the continuous
 extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of scr
Use a rotating, moving or blank screen saver (this prevents an image from bein
Rotate desktop background images every few days.
Turn the monitor off when the system is not in use.
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Overview 1 - 1

Quick Start Guide 1

C
O
T  computer, to navigating around the
co covers the following:

• g. the storage devices (hard disk, 
uchPad & Mouse, Audio & Printer.

•
• ration or improvement of some of the 

• c Input Output System).
•
• reless LAN, 3.75G/HSPA and Secu-

our purchase configuration).
•
• mputer to communicate with external 

•
•

hapter 1: Quick Start Guide
verview

his Quick Start Guide is a brief introduction to the basic features of your
mputer and to getting your system started. The remainder of the manual 

Chapter 2 A guide to using some of the main features of the computer e.
optical device, 7-in-1 card reader, ExpressCard/34/54), To

Chapter 3 The computer’s power saving options.
Chapter 4 The installation of the drivers and utilities essential to the ope

computer’s subsystems.
Chapter 5 An outline of the computer’s built-in software or BIOS (Basi
Chapter 6 Instructions for upgrading your computer.
Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wi

rity modules (some of which may be optional depending on y
Chapter 8 A troubleshooting guide.
Appendix A Definitions of the interface, ports/jacks which allow your co

devices.
Appendix B Information on the ATI Video driver controls.
Appendix C The computer’s specification.
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1
A
If ide. However you may find it useful
to and “Upgrading The Computer” on
p s marked with a  of interest to you.

B
 advanced knowledge of them) then
uide should be enough to get you up
through all the documentation (more
d system controls are covered in the
orry if you do not understand every-
d refer to it to learn as you go. You
with a  as indicated in the margin.
erface ports and jacks see “Interface

W
N  safety information indicated by the

ted in the Preface.
 - 2 Overview

Quick Start Guide

dvanced Users
 you are an advanced user you may skip over most of this Quick Start Gu
 refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 

age 6 - 1 in the reminder of the User’s Manual. You may also find the note

eginners and Not-So-Advanced Users
If you are new to computers (or do not have an
the information contained in the Quick Start G
and running. Eventually you should try to look 
detailed descriptions of the functions, setup an
remainder of the User’s Manual), but do not w
thing the first time. Keep this manual nearby an
may find it useful to refer to the notes marked 
For a more detailed description of any of the int
(Ports & Jacks)” on page  A - 1.

arning Boxes
o matter what your level please pay careful attention to the warning and
 symbol. Also please note the safety and handling instructions as indica

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
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N
O ord processing, spreadsheet and da-
ta e manuals.

ifferent system, you will need to install
h act as an interface between the com-
t that you install the drivers in the order
rs and utilities are properly installed. If
ve already done that for you); refer to

omputer to communicate with external
ot Included
perating Systems (e.g. Windows Vista/Windows 7) and applications (e.g. w
base programs) have their own manuals, so please consult the appropriat

Drivers

If you are installing new system software, or are re-configuring your computer for a d
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs whic
puter and a hardware component e.g. a wireless network module. It is very importan
listed. You will be unable to use most advanced controls until the necessary drive
your system hasn’t been properly configured (your service representative may ha
Chapter 4 for installation instructions.

Ports and Jacks

See Appendix A for a description of the interface (ports & jacks) which allow your c
devices, connect to the internet etc.
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1
2
3 eyboard and mouse) to their ports.
4 en plug the AC power cord into an 

5 xceed 120 degrees); use the other 
uter (Note: Never lift the computer by 

Adapter Plugged-In

ommand from the Lock Button Menu
 - 4 Overview

Quick Start Guide

ystem Startup
. Remove all packing materials.
. Place the computer on a stable surface.
. Securely attach any peripherals you want to use with the notebook (e.g. k
. Attach the AC/DC adapter to the DC-In jack on the left of the computer, th

outlet, and connect the AC power cord to the AC/DC adapter.
. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not e

hand (as illustrated in Figure 1 - 1 below) to support the base of the comp
the lid/LCD).

Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC 

Shutdown

Note that you should always shut your computer down by choosing the Shut Down c
in Windows Vista. This will help prevent hard disk or system problems.
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S
Y ere this is not the case, or where you
ar ollowing operating systems are sup-
p

ed

Note

r to run Windows Vista/Windows 7
 limitations or decreased performance,
omputer requires a minimum 1GB of
 memory (RAM).

includes Service Pack 2) before installing
.

ystem Software
our computer may already come with system software pre-installed. Wh
e re-configuring your computer for a different system, you will find the f

orted (see Appendix D for Windows 7 specific information).

Table 1 - 1 - Operating Systems Support

Operating System & Version

Windows Vista - SP2 (Home Basic, Home Premium, Business, Enterprise 
and Ultimate Editions)

In orde
without
your c
systemWindows 7

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which 
any drivers. Go to the Microsoft website for download details, or contact your service center
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M
T  indicated in the table below however
al

Model B

D 16:9 Wide Screen (1366 * 768) / 
HD+ (1600 * 900) / 

HD (1920 * 1080) TFT LCD
 - 6 Model Differences

Quick Start Guide

odel Differences
his notebook series includes two different model types. The models differ as
l other features, modules and specifications are identical (see Appendix D).

Table 1 - 2 - Model Differences

Feature Model A

Display Type 
Supported

17" WXGA(1440 * 900) / 
WUXGA (1920 * 1200) TFT LCD

15.6" H

F

Design
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Figure 1 - 2
LCD Panel Open

(Model A Computers)

1. Built-In PC Camera 
2. LCD
3. Power Button
4. Hot Key Buttons
5. Keyboard
6. Built-In Microphone
7. Touchpad & 

Buttons
8. Fingerprint Module 

(Optional)
9. LED Indicators

9

craft

ic trans-
is usually
le(s) are
r aboard

le power
luetooth
indicator

wered on
e 1 - 13/

a)
System Map: LC

ystem Map: LCD Panel Open - Model A

2

4

1

6

7

3

5

Wireless Device 
Operation Aboard Air

The use of any portable electron
mission devices aboard aircraft 
prohibited. Make sure the modu
OFF if you are using the compute
aircraft.

Use the key combinations to togg
to the 3.75G/HSPA/WLAN/B
modules, and check the LED 
icon to see if the modules are po
or not (see Table 1 - 6, on pag
Table 1 - 4, on page 1 - 9).

   Touchpad Buttons
(valid operation are

7

9
8
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1
pen - Model B

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard air-
craft is usually prohibited. Make
sure the module(s) are OFF if you
are using the computer aboard air-
craft.

Use the key combinations to toggle
power to the 3.75G/HSPA/WLAN/
Bluetooth modules, and check the
LED indicator icon to see if the
modules are powered on or not
(see Table 1 - 6, on page 1 - 13/
Table 1 - 4, on page 1 - 9).

uchpad Buttons (valid operation area)

7

 - 8 System Map: LCD Panel Open - Model B
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System Map: LCD Panel O
Figure 1 - 3

LCD Panel Open
(Model B Computers)

1. Built-In PC Camera 
2. LCD
3. Power Button
4. Hot Key Buttons
5. Keyboard
6. Built-In Microphone
7. Touchpad & 

Buttons
8. LED Indicators

Note: The Fingerprint
Reader module is also an
option for Model B com-
puters.

8

2

4

1

6

7

3

5

   To
8



LED Indicators 1 - 9

Quick Start Guide 1
L
T
in

Power & Communication Indicators

lor Description

nge DC Power is Plugged In

en The Computer is On

 Green The Computer is in Sleep 
Mode

nge The Battery is Charging

en The Battery is Fully Charged

 Orange The Battery Has Reached 
Critically Low Power Status

en The (optional) Wireless LAN 
Module is Powered On

nge The (optional) Bluetooth 
Module is Powered On
ED Indicators
he LED indicators on the computer display helpful
formation about the current status of the computer.

Table 1 - 3 - LED Status Indicators

Table 1 - 4 - LED 

Icon Color Description

Green Hard Disk Activity

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated (to activate 
press Fn & Scr Lk)

Icon Co

Ora

Gre

Blinking

Ora

Gre

Blinking

Gre

Ora



1

1
rd

nternet browser and e-mail program,
 with one quick button press.

 Buttons

noise and save power consumption.

ction

r (Note that in Windows 7 this button 
 or Outlook Express are installed)

ult Internet Program

de (for power saving)

ters

used with Alt to produce special characters.
e numeric keypad. Regular number keys (in
at NumLk is on.
 - 10 Hot Key Buttons & Keyboard

Quick Start Guide

Hot Key Buttons & Keyboa
These buttons give instant access to the default I
and allow you to toggle the Silent Mode on/off

Table 1 - 5 - Hot Key

*When enabled, Silent Mode will reduce fan 
Note this may reduce computer performance.

Hot Key Fun

Activate the Default E-Mail Browse
will only function after Outlook

 Activate the Defa

Toggle *Silent Mo

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.

Special Charac

Some software applications allow the number-keys to be 
These special characters can only be produced by using th
the upper row of the keyboard) will not work. Make sure th



Keyboard - Model A 1 - 11

Quick Start Guide 1
K
T input, and features function keys to
al e 1 - 13 for full function key combi-
n

Numerical Keypad 

NumLk & 
ScrLk Keys

y

A Module
eyboard - Model A
he keyboard has a numerical keypad on the right for easy numeric data 
low you to change operational features instantly. See Table 1 - 6, on pag
ation details.

Figure 1 - 4 - Keyboard - Model A

Play/Pause Key

Function Keys

Fn Key

Toggle Ke

3.75G/HSP
Power 
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1
K
T input, and features function keys to
al e 1 - 13 for full function key combi-
n

Numerical Keypad 

NumLk & 
ScrLk Keys

y

A Module
 - 12 Keyboard - Model B
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eyboard - Model B
he keyboard has a numerical keypad on the right for easy numeric data 
low you to change operational features instantly. See Table 1 - 6, on pag
ation details.

Figure 1 - 5 - Keyboard - Model B

Play/Pause Key

Function Keys

Fn Key

Toggle Ke

3.75G/HSP
Power 
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F
T the Fn key is held down. In addition
to n the hot key utility is installed.

rs

Function

crease

See “Switching Displays 
Using Fn + F7” on page B - 4

Increase

er 

r Toggle

er Toggle

 fan noise and save power consumption. Note this 
omputer performance.
Func

unction/Hot Key Indicators
he function keys (F1 - F12 etc.) will act as hot keys when pressed while 
 the basic function key combinations; visual indicators are available whe

Table 1 - 6 - Function & Hot Key Indicato

Fn Keys Function Fn Keys

Fn + ~ Play/Pause 
(in Audio/Video Programs) Fn + F5/F6 Volume Decrease/In

Fn + _ 
3.75G Module 
Power Toggle* Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/F9 Brightness Decrease/

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F10 PC Camera Pow

Toggle

Fn + F3 Mute Toggle Fn + F11 WLAN Module Powe

Fn + F4  Sleep Toggle Fn + F12 Bluetooth Module Pow

*Silent Mode Toggle  *When enabled, Silent Mode will reduce
may reduce c
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Views

der

pular digital storage card formats:

gital) / MS (Memory Stick) / 
 (requires PC adapter) / 
C (requires PC adapter)

9
10

8
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System Map: Front & Left 
Figure 1 - 6

Front & Left Views

1. LED Power & Com-
munication Indica-
tors

2. DC-In Jack
3. External Monitor 

Port
4. RJ-45 LAN Jack
5. e-SATA Port 
6. HDMI-Out Port
7. Vent/Fan Intake/

Outlet
8. 2 * USB 2.0 Ports
9. ExpressCard Slot 

(see page 2 - 7)
10. 7-in-1 Card Reader

1

2 5
4

1

6
3

7-in-1 Card Rea

The card reader allows you to use the most po

MMC (MultiMedia Card) / SD (Secure Di
MS Pro (Memory Stick Pro) / MS Duo

Mini SD (requires PC adapter) / RS MM
\

7
8
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S Figure 1 - 7

Right & Rear Views

1. S/PDIF-Out Jack
2. Microphone-In 

Jack
3. Headphone-Out 

Jack
4. USB 2.0 Port
5. Optical Device 

Drive Bay (for CD/
DVD Device - see 
page 2 - 3)

6. RJ-11 Phone Jack
7. Security Lock Slot
8. Battery

Disk Eject Warning

Don’t try to eject a CD/DVD
while the system is accessing
it. This may cause the system
to “crash”. Stop the disk first
then eject it, or press the stop
button twice.

7

s

 Device
ick the +
k on the
s dialog
bring up
 regional

, not OS-
’s region
ent. This
perating

omputer.
System M

ystem Map: Right & Rear Views

1 52 4

8

3
6

CD/DVD Emergency Eject

If you need to manually eject a CD/
DVD (e.g. due to an unexpected
power interruption) you may push the
end of a straightened paper clip into
the emergency eject hole. Do not use
a sharpened pencil or any object that
may break and become lodged in the
hole. Don’t try to remove a floppy
disk/CD/DVD while the system is ac-
cessing it. This may cause the sys-
tem to “crash”.

Changing DVD Regional Code

Go to the Control Panel and double-click
Manager (Hardware and Sound), then cl
next to DVD/CD-ROM drives. Double-clic
DVD-ROM device to bring up the Propertie
box, and select the DVD Region (tab) to 
the control panel to allow you to adjust the
code.

DVD region detection is device dependent
dependent. You can select your module
code 5 times. The fifth selection is perman
cannot be altered even if you change your o
system or you use the module in another c
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 - Model A 

2

3

1

5

3

3

6

re nothing blocks the Vent/Fan Intake
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System Map: Bottom View
Figure 1 - 8

Bottom View
(Model A 

Computers) 

1. Battery
2. RAM & CPU Bay 

Cover
3. Vent/Fan Intake/

Outlet
4. Hard Disk Bay 

Cover
5. 3.75G/HSPA 

USIM Card 
Location

6. Speakers

4

6

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Energy Star Power
Saving” on page 3 - 10 for
full instructions.

CPU
The CPU is not a user serviceable part.

Overheating
To prevent your computer from overheating make su
while the computer is in use.
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Figure 1 - 9
Bottom View

(Model B 
Computers) 

1. Battery
2. RAM & CPU Bay 

Cover
3. Vent/Fan Intake/

Outlet
4. Hard Disk Bay 

Cover

Note: the 3.75G/HSPA
USIM Card is located un-
der the RAM & CPU Bay
Cover.

Intake
System Map:

ystem Map: Bottom View - Model B 

2

3

1

4
3

3

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Energy Star Power
Saving” on page 3 - 10 for
full instructions.

CPU
The CPU is not a user serviceable part.

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan 
while the computer is in use.
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1
W l
M d most other Windows versions) are
ac y will be installed on your hard disk
d esktop. Right-click the Start menu
ic ce of the Start menu.

In en the Control Panel. The Control
P  settings for most of the key features
in es basic controls for many of the fea-
tu d) when you install the drivers listed
in gle to Classic View on.

art Menu & Control Panel

Click here to toggle Classic View
 - 18 Windows Vista Start Menu & Control Panel
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indows Vista Start Menu & Control Pane
ost of the control panels, utilities and programs within Windows Vista (an
cessed from the Start menu. When you install programs and utilities the

rive, and a shortcut will usually be placed in the Start menu and/or the d
on , and then select Properties if you want to customize the appearan

 many instances throughout this manual you will see an instruction to op
anel is accessed from the Start menu, and it allows you to configure the
 Windows (e.g. power, video, network, audio etc.). Windows Vista provid
res, however many new controls are added (or existing ones are enhance
 Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to tog

Figure 1 - 10 - St

 



Video Features 1 - 19
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V
Y el in Windows as long as the appro-
p e “ATI Video Driver Controls” on
p

T
1 l Panel).
2 ion menu (or double-click 

3 n page 1 - 20).
4 - 11 on page 1 - 20).
5

T nformation):
1
2 ).
3  20) to access the control panel.
4 anel (you can select Basic or 
ideo Features
ou can configure display options, from the Display Settings control pan
riate video driver is installed. For more detailed video information se
age B - 1.

o access Display Settings in Windows:
. Click Start, and click Control Panel (or point to Settings and click Contro
. Click Adjust screen resolution under the Appearance and Personalizat

Personalization > Display Settings).
. Move the slider to the preferred setting in Resolution:  (Figure 1 - 11 o
. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 
. Click Advanced Settings (button)  (Figure 1 - 11 on page 1 - 20).

o access the ATI Catalyst Control Center (See Appendix B for detailed i
. Click Advanced Settings (button)  (Figure 1 - 11 on page 1 - 20).
. Click ATI Catalyst Control Center (tab)  (Figure 1 - 11 on page 1 - 20
. Click ATI Catalyst Control Center (button)  (Figure 1 - 11 on page 1 -
. You can select Basic or Advanced options on the first run of the control p

Advanced views from the View menu at any time).

1
2

3

3
4

5



1

1
D
B RT)/external Flat Panel Display as
y

trols

Check with your service center for the latest
 - 20 Video Features

Quick Start Guide

isplay Devices & Options
esides the built-in LCD, you can also use an external VGA monitor (C
our display device.

Figure 1 - 11 - Display Settings & ATI Con

1 2

3

5

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. 
details on video cards supported.
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P
T indows (see page 1 - 17) allows you
to rve power by means of power plans
an id (when closed), display and sleep
m ect on computer performance.

C e left menu and select the options to
cr  power settings to access further con-
fi

P ving” on page 3 - 10.

Windows Vista
ower Options
he Power Options (Hardware and Sound menu) control panel icon in W
 configure power management features for your computer. You can conse
d configure the options for the power button, sleep button, computer l
ode from the left menu. Note that the Power saver plan may have an aff

lick to select one of the existing plans, or click Create a power plan in th
eate a new plan. Click Change Plan Settings and click Change advanced
guration options.

ay attention to the instructions on battery care in “Energy Star Power Sa

Figure 1 - 12 - Power Options
Note: Sleep is the default power saving state in 
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Features & Components

Overview 2 - 1

2C ts
O
R ponents
o

•
•
•
•
•
•
•

hapter 2: Features & Componen
verview

ead this chapter to learn more about the following main features and com
f the computer:

Hard Disk Drive
Optical (CD/DVD) Device
7-in-1 Card Reader
ExpressCard Slot
TouchPad and Buttons/Mouse
Audio Features
Adding a Printer



2

2
 the computer. The hard disk can be
TA) hard disk drives (see “Storage”

our computer as seen below. For fur-
ve” on page 6 - 4.

Model B

2

3

Features & Components

- 2 Hard Disk Drive

Hard Disk Drive
The hard disk drive is used to store your data in
taken out to accommodate other 2.5" serial (SA
on page C - 2) with a height of 9.5 mm.

The hard disk is accessible from the bottom of y
ther details see “Upgrading the Hard Disk Dri

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location

Model A

21

3

1



Features & Components

ptical (CD/DVD) Device 2 - 3

2O
T ctual de-
v - 2). The
o device if
p

L
T VD onto
th lick onto
th  and you
ar ccessed,
o nterrupt-
ed ject hole

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 11).

 Figure 2 - 2
Optical Device

3

O

ptical (CD/DVD) Device
here is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The a
ice will depend on the module you purchased (see “Storage” on page C 
ptical device is usually labeled “Drive D:” and may be used as a boot 
roperly set in the BIOS (see “Boot Menu” on page 5 - 12).

oading Discs
o insert a CD/DVD, press the open button  and carefully place a CD/D
e disc tray with label-side facing up (use just enough force for the disc to c
e tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks”
e ready to start. The busy indicator  will light up while data is being a

r while an audio/video CD, or DVD, is playing. If power is unexpectedly i
, insert an object such as a straightened paper clip into the emergency e
 to open the tray.

1

2

12 3



2

2 nt them from being damaged. Please
ata stored on your CDs/DVDs can be

ouch the surface of the disc.
r fingerprints.

 surface of the disc.
h-temperature areas.
rs to clean the CD or DVD.

ock.
Features & Components

- 4 Optical (CD/DVD) Device

Handling CDs or DVDs
Proper handling of your CDs/DVDs will preve
follow the advice below to make sure that the d
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not t
• Use a clean, soft, dry cloth to remove dust o
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the
• Do not store or place the CD or DVD in hig
• Do not use benzene, thinner, or other cleane
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to sh

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.



Features & Components

ptical (CD/DVD) Device 2 - 5

2D
T des” on
p
.

Table 2 - 1
DVD Regional Coding
O

VD Regional Codes
o change the DVD regional codes see “Changing DVD Regional Co
age 1 - 15.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China



2

2
 latest digital storage cards. Push the
able device, and can be accessed in

e you install the Card Reader driver

ith these cards.

S Duo (requires PC adapter*)
ini SD (requires PC adapter*)
S MMC (requires PC adapter*)

1

Features & Components

- 6 7-in-1 Card Reader

7-in-1 Card Reader
The card reader allows you to use some of the
card into the slot and it will appear as a remov
the same way as your hard disk (s). Make sur
(see “CardReader” on page 4 - 6).

*Note: The PC adapters are usually supplied w

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 3
Left View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• M
• M
• R
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ExpressCard Slot 2 - 7

2E
T ss Card/
3 CIA (PC
C n page 4
- 

E slot, e.g.
C r the Ex-
p

In
• ce (as 

•

ExpressCard 
Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

 Figure 2 - 4
Left View

1. Express Card 
Slot

 Figure 2 - 5
Inserting & 

Removing Express 
Cards
xpressCard Slot
he computer is equipped with an ExpressCard/34/54 slot that reads Expre
4 and ExpressCard/54 formats. ExpressCards are the successors to PCM
ards). Make sure you install the Card Reader driver (see “CardReader” o
6).

xpressCard/54 is used for applications which require a larger interface 
ompactFlash card reader. The number denotes the card width; 54mm fo
ress Card/54 and 34mm for the ExpressCard/34.

serting and Removing ExpressCards
Align the ExpressCard with the slot and push it in until it locks into pla
pictured in the generic figure below).
To remove an ExpressCard, simply press the card to eject it.

1



2

2 use
owever, you can also add a mouse to
. The TouchPad buttons function in

see “TouchPad” on page 4 - 6) you
 the TouchPad driver icon  on the
d tapping, buttons, scrolling, pointer
es. You will find further information
Features & Components

- 8 TouchPad and Buttons/Mouse

TouchPad and Buttons/Mo
The TouchPad is an alternative to the mouse; h
your computer through one of the USB ports
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (
can configure the functions by double-clicking
taskbar. You may then configure the TouchPa
motion and sensitivity options to your preferenc
at www.synaptics.com.

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 6
Mouse Properties
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ad and Buttons/Mouse 2 - 9

2G
T ture (ac-
ti late doc-
u

Y perties:
1  Panel).
2
3
4

 Figure 2 - 7
Mouse Properties - 

Device Settings
TouchP

estures and Device Settings
he Synaptics Gestures Suite application allows you to use a specific ges
on) on the surface of the TouchPad to perform specific actions to manipu
ments, objects and applications.

ou can configure the settings from the Device Settings tab in Mouse Pro
. Click Start, and click Control Panel (or point to Settings and click Control
. Click Mouse (Hardware and Sound).
. Click Device Settings (tab) and click Settings.
. Use the menu tree on the left to access the user configurable settings.



2

2  scrollable windows and allows you
o fingers, slightly separated, on the
direction required (in a straight con-

 the same function as a scroll wheel
+ scroll wheel zoom functionality.
sults use the tips of the fingers) and
to zoom out.

.g. photos) in 90 degree increments.
nd keep it stationary. Place another
de it in a circular motion around the
se) to rotate the object.

ress)
to enhance navigation with a variety
or scrolling through a photo viewer.
 launch user-selectable applications.
Features & Components

- 10 TouchPad and Buttons/Mouse

Scrolling
The two finger scrolling feature works in most
to scroll horizontally and vertically. Place tw
TouchPad surface and slide both fingers in the 
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform
in Windows applications that support CTRL 
Place two fingers on the TouchPad (for best re
slide them apart to zoom in, or closer together 

Rotating
Use the Pivot Rotate gesture to rotate objects (e
Place a finger down on the left “target” zone a
finger near the middle of the TouchPad and sli
stationary finger (clockwise or counterclockwi

Three Finger-Flick/Three Fingers Down (P
These Three Finger-Flick gesture may be used 
of applications such as browsing the Internet 
The Three Fingers Down gesture may be used to

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture
(Pinch Zoom, Rotat-
ing, Three Fingers
Down and Three Fin-
ger Flick) in the De-
vice Settings >
Settings left tree menu
and click the Show
Video button to see
the demonstration vid-
eo.

For more details on
any of the gestures see
the help in the lower
part of the right menu
window.
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2A
Y  control
p  taskbar/
co  volume
m

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 8
Realtek Audio 

Manager
udio Features
ou can configure the audio options on your computer from the Sound 
anel in Windows, or from the Realtek HD Audio Manager  icon in the
ntrol panel (right-click the taskbar  icon bring up an audio menu). The
ay also be adjusted by means of the Fn + F5/F6 key combination. 

Right-click the icon 
to access the menu 
above.
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2
ter. The following conventions will
best to refer to the printer manual for

nection. You may use any one of the

 (unpacking, paper tray, toner/ink car-

e USB ports on the computer.
oad one of its own drivers or ask you 
ons.

install instructions are in the sidebar,
 USB converter.
Features & Components

- 12 Adding a Printer

Adding a Printer
The most commonly used peripheral is a prin
help you to add a printer; however it is always 
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface con
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of th
5. Windows will identify the printer and either l

to supply one. Follow the on-screen instructi

Parallel Printer
This is still a very common type of printer. The 
however you will need to purchase a parallel to

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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C
O
T er man-
ag omputer
(t :

•
•
•
•
•
•
•

T g system
(O sors. For
ex  user set-
ti

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
hapter 3: Power Management
verview

o conserve power, especially when using the battery, your computer pow
ement conserves power by controlling individual components of the c

he monitor and hard disk drive) or the whole system. This chapter covers

The Power Sources
Turning on the Computer
Power Plans
Power-Saving States
Configuring the Power Buttons
Energy Star Power Saving
Battery Information

he computer uses enhanced power saving techniques to give the operatin
S) direct control over the power and thermal states of devices and proces
ample, this enables the OS to set devices into low-power states based on

ngs and information from applications.
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3
/DC adapter or a battery pack.

ur computer. The wrong type of AC/
omponents.

on the left of the computer.
en connect the AC power cord to the 

ngle.

hile you are on the road or when an
es depending on the applications and
ttery life, let the battery discharge
 completely discharge the battery?”

ery. For more information on the bat-
g” on page 3 - 10.
Power Management

- 2 The Power Sources

The Power Sources
The computer can be powered by either an AC

AC/DC Adapter
Use only the AC/DC adapter that comes with yo
DC adapter will damage the computer and its c

1. Attach the AC/DC adapter to the DC-in jack 
2. Plug the AC power cord into an outlet, and th

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing a
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer w
electrical outlet is unavailable. Battery life vari
the configuration you're using. To increase ba
completely before recharging (see “How do I
on page 3 - 15).

We recommend that you do not remove the batt
tery, please refer to “Energy Star Power Savin

Silent Mode

Use the  key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.
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3

T
N the pow-
er

W nate hot-
k e power
b wer Op-
ti onfigure
th

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

e pow-

conds.
dware
ion, or
Tu

urning on the Computer
ow you are ready to begin using your computer. To turn it on simply press 
 button on the front panel.

hen the computer is on, you can use the power button as a Sleep/Hiber
ey button when it is pressed for less than 4 seconds (pressing and holding th
utton for longer than this will force the computer to shut down). Use Po
ons (Hardware and Sound menu) control panel in Windows Vista to c
is feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press th
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 se
You may configure the options for the power button from the Power Options (Har
and Sound menu) control panel in Windows Vista (see your OS’s documentat
“Configuring the Power Buttons” on page 3 - 8 for details).
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3
wer by means of power plans. You
 create a new one.

to turn off after a specified time, and
f inactivity. 

nge advanced power settings to ac-
 Settings.
Power Management

- 4 Power Plans

Power Plans
The computer can be configured to conserve po
can use (or modify) an existing power plan, or

The settings may be adjusted to set the display 
to send the computer into Sleep after a period o

Click Change plan settings and then click Cha
cess further configuration options in Advanced

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
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3

E our ma-
c riencing
an

C r is pow-
er that this
sc r to save
p er) pow-
er

ATI PowerPlay™

PowerPlay™ in the ATI
Catalyst Control Cen-
ter (in the Graphics Set-
tings Tree View pane)
allows you to set your
graphics processor set-
tings for higher perfor-
mance or longer battery
life.

Figure 3 - 2
Power Plans
ach Windows power plan will also adjust the processor performance of y
hine in order to save power. This is worth bearing in mind if you are expe

y reduced performance (especially under DC/battery power).

hoose High performance for maximum performance when the compute
ed from an AC power source. Choose the Power saver (bear in mind 
heme may slow down the overall performance of the computer in orde

ower) for maximum power saving when the computer is battery (DC pow
ed.
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3
mputer’s operation and restart where
state in Windows Vista.

d Hibernate as system power-saving
 Stand By and Hibernate into the de-

ces are saved to memory before the
mputer for a certain length of time,
ill enter Sleep to save power. 

will return you to where you last left
ing the application(s) and file(s) you

ry power the system will use only a
 period the system will save all the
ter down before the battery becomes
Power Management

- 6 Power-Saving States

Power-Saving States
You can use power-saving states to stop the co
you left off. Sleep is the default power-saving 

Earlier versions of Windows used Stand By an
states. Windows Vista combines the features of
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferen
system sleeps. When you are not using your co
which you specify in the operating system, it w

The PC wakes from Sleep within seconds and 
off (what was on your desktop) without reopen
last used.

If your mobile PC in Sleep is running on batte
minimum amount of power. After an extended
information to the hard disk and shut the compu
depleted.

Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
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3

H
H nd saves
al  off. If a
p  a power
fa lost. Hi-
b u should
p eriod of
ti

S
Y on’t for-
g  6), plan
to e up and
ru ger than
fr

Figure 3 - 3
Lock Button Menu
ibernate
ibernate uses the least amount of power of all the power-saving states a
l of your information on a part of the hard disk before it turns the system
ower failure occurs the system can restore your work from the hard disk; if
ilure occurs when work is saved only to memory, then the work will be 
ernate will also return you to where you last left off within seconds. Yo
ut your mobile PC into Hibernate if you will not use the computer for a p
me, and will not have the chance to charge the battery.

hut Down
ou should shut down the computer if you plan to install new hardware (d
et to remove the battery and follow all the safety instructions in Chapter
 be away from the computer for several days, or you do not need it to wak
n a scheduled task. Returning to full operation from shut down takes lon
om Sleep or Hibernate.
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ttons
and closed lid may be set to send the
Power Management

- 8 Configuring the Power Buttons

Configuring the Power Bu
The power/sleep button (Fn + F4 key combo) 
computer in to a power-saving state.Password 

Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
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3

R
Y r button,
o

 Combo)

uchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

 Down
 power
Configu

esuming Operation
ou can resume operation from power-saving states by pressing the powe
r in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/To

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut
hot key button when it is pressed for less than 4 seconds (pressing and holding the
button for longer than this will force the computer to shut down).
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3
agement features that place comput-
eep modes after a designated period
r power saving then follow these in-

ower management and override other 
Power Management

- 10 Configuring the Power Buttons

Energy Star Power Saving
This system supports Energy Star power man
ers (CPU, hard drive, etc.) into a low-power sl
of inactivity. If you want to enable Energy Sta
structions:

1. Right-click the taskbar icon .
2. Select Power Conservation Modes.
3. Select Energy Star to use the Energy Star p

power saving settings.

Figure 3 - 5
Energy Star Menu
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3

Ba
Foll

Ba
You e pro-
gram  to be
take s from
pow

Clic charge
stat

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 6
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
ttery Information
ow these simple guidelines to get the best use out of your battery.

ttery Power
r computer’s battery power is dependent upon many factors, including th
s you are running, and peripheral devices attached. You can set actions

n (e.g. Shut down, Hibernate etc.), and set critical and low battery level
er plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

k the battery icon  in the taskbar to see the current battery level and 
us.
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3
 Power saver), however note that 
ance.

lay. The system will decrease LCD 
not powered by the AC/DC adapter.

y is turned off.

unication applications when they are 

al devices e.g. USB devices, 
Power Management

- 12 Battery Information

Conserving Battery Power
• Use a power plan that conserves power (e.g

this may have an affect on computer perform

• Lower the brightness level of the LCD disp
brightness slightly to save power when it is 

• Reduce the amount of time before the displa

• Close wireless, Bluetooth, modem or comm
not being used.

• Disconnect/remove any unnecessary extern
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 7
Windows Mobility 

Center
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B
B  the life
a  at least
o

W ed to re-
m Battery”
o

N
A y FAQ”
o

R
T ched and
p e, it will
ta d off but
p  Indica-
to rgy Star
P nd prop-
er
attery Life
attery life may be shortened through improper maintenance. To optimize
nd improve its performance, fully discharge and recharge the battery
nce every 30 days.

e recommend that you do not remove the battery yourself. If you do ne
ove the battery for any reason (e.g. long term storage) see “Removing the 

n page 6 - 3.

ew Battery
lways completely discharge, then fully charge, a new battery (see “Batter
n page 3 - 15 for instructions on how to do this).

echarging the Battery with the AC/DC Adapter
he battery pack automatically recharges when the AC/DC adapter is atta
lugged into an electrical outlet. If the computer is powered on, and in us
ke several hours to fully recharge the battery. When the computer is turne
lugged into an electrical outlet, battery charge time is less. (Refer to “LED
rs” on page 1 - 9 for information on the battery charge status, and to “Ene
ower Saving” on page 3 - 10 for more information on how to maintain a
ly recharge the battery pack.)
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3
r any circumstances
emperatures, it may explode
to each other

Warning

attery is bent out of shape after being
e notebook battery, shut your computer
 If the battery has been dropped we do
omputer continues to work with a dam-
, which may possibly result in fire. It is
ery every two years.
Power Management

- 14 Battery Information

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack unde
• DO NOT expose the battery to fire or high t
• DO NOT connect the metal terminals (+, -) 

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery 

Should you notice any physical defects (e.g. the b
dropped), or any unusual smells emanating from th
down immediately and contact your service center.
not recommend using it any further, as even if the c
aged battery in place, it may cause circuit damage
recommended that you replace your computer batt
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3

B
H
U y. Don’t
tu , just let
th

1
2  Never.
3  power 

Figure 3 - 8
Power Plan Create
attery FAQ
ow do I completely discharge the battery?
se the computer with battery power until it shuts down due to a low batter
rn off the computer even if a message indicates the battery is critically low
e computer use up all of the battery power and shut down on its own.

. Save and close all files and applications.

. Create a power plan for discharging the battery and set all the options to

. Click Change plan settings (after saving it) and click Change advanced
settings.
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 the battery options.
ning appears):

own
thing
Power Management

- 16 Battery Information

4. Scroll down to Battery and click + to expand
5. Choose the options below (click Yes if a war

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut d
• Critical battery action (Plugged in) = Do No

Figure 3 - 9
Power Options 

Advanced Settings - 
Battery
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3

H
W  changes
fr

H
C  or after
ab
ow do I fully charge the battery?
hen charging the battery, don’t stop until the LED charging indicator light

om orange to green.

ow do I maintain the battery?
ompletely discharge and charge the battery at least once every 30 days
out 20 partial discharges.
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Drivers & Utilities

What to Install 4 - 1

4

C
T
ti
o
v
w
sy
so
u
at
m
u

stall
rs & Utilities + User’s Manual disc
ers and utilities necessary for the

of the computer.

ge 4 - 3 lists what you need to install
portant that the drivers are in-

der indicated (see “Windows 7 In-
page D - 1 for Windows 7

r Installation
r installing drivers for the Wireless
ra, 3.75G/HSPA and Fingerprint
ided in “Modules & Options” on
hapter 4: Drivers & Utilities
his chapter deals with installing the drivers and utili-
es essential to the operation or improvement of some
f the computer’s subsystems. The system takes ad-
antage of some newer hardware components for
hich the latest versions of most available operating
stems haven’t built in drivers and utilities. Thus,
me of the system components won’t be auto-config-

red with an appropriate driver or utility during oper-
ing system installation. Instead, you need to
anually install some system-required drivers and

tilities. 

What to In
The Device Drive
contains the driv
proper operation 

Table 4 - 1, on pa
and it is very im
stalled in the or
formation” on 
information).

Module Drive
The procedures fo
LAN, PC Came
modules are prov
page 7 - 1.
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4

D
In
d

If
fo

er installation order from Table 4 - 1, 
 (the drivers must be installed in 
hich is the same as that listed in the 
ller menu below.
 the driver you wish to install, after 
 driver it will become grayed out. If 
install any driver, click the Unlock 
ould uninstall the driver first).
tructions for each individual driver 
cedure as listed on the following 

 2 - Drivers Installer Screen 2
Drivers & Utilities

- 2 Driver Installation

river Installation
sert the Device Drivers & Utilities + User’s Manual

isc and click Install Drivers/Option Drivers (button).

 you wish to install the drivers manually see overleaf
r the driver path information.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driv
on page 4 - 3
this order) w
Drivers Insta

2. Click to select
installing each
you need to re
button (you sh

3. Follow the ins
installation pro
pages.

 
Figure 4 -
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Driver Installation 4 - 3

4

stallation
 (button) in the Drivers Installer ap-
wse to the executable file in the ap-
lder.

e
ll the drivers make sure you enable
e in order to get all the latest security
pdates will include the latest hotfixes
See “Windows Update” on page 4 -

ows Vista Service Pack 2

nstall Windows Vista Service Pack 2
Vista version which includes Service
stalling any drivers. Go to the Micro-

ownload details, or contact your service
Table 4 - 1 - Driver Installation

Manual Driver In
Click Browse CD
plication and bro
propriate driver fo

Windows Updat
After installing a
Windows Updat
updates etc. (all u
from Microsoft). 
7 for instructions.

Driver - Windows Vista with Service Pack 2 Page

Chipset Page 4 - 5

Video Page 4 - 5

Audio Page 4 - 6

Modem Page 4 - 6

LAN Page 4 - 6

TouchPad Page 4 - 6

CardReader Page 4 - 6

Hot Key Page 4 - 6

Wireless LAN Module Page 7 - 8

PC Camera Module Page 7 - 26

3.75G/HSPA Module Page 7 - 33

Fingerprint Reader Module Page 7 - 51

Wind

Make sure you i
(or a Windows 
Pack 2) before in
soft website for d
center.
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th
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If
tu

1

2
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4

t Control (Win Vista)
t Control prompt appears as part of
ation procedure, click Continue or
 the installation procedure as direct-

curity Message
indows security message as part of

tion process. Just click “Install this
nyway” or “Install” to continue the
dure.

his message in cases where the driv-
ed after the version of Windows you
g. All the drivers provided will have
ertification for Windows.
Drivers & Utilities

- 4 Driver Installation

pdating/Reinstalling Individual Drivers
 you wish to update/reinstall individual drivers it
ay be necessary to uninstall the original driver.To do
is go to the Control Panel in the Windows OS and

ouble-click the Programs and Features icon (Pro-
rams > Uninstall a program). Click to select the
river (if it is not listed see below) and click Uninstall,
d then follow the on screen prompts (it may be nec-
sary to restart the computer). Reinstall the driver as

utlined in this chapter.

 the driver is not listed in the Programs and Fea-
res menu:

. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

. Double-click Device Manager (Hardware and 
Sound > Device Manager).

. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Accoun
If a User Accoun
the driver install
Allow, and follow
ed.

Windows Se
If you receive a W
the driver installa
driver software a
installation proce

You will receive t
er has been releas
are currently usin
already received c
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4

N
If
in
li
to
d

ation Procedure
Drivers & Utilities + User’s Manual
tall Drivers (button).

ll Chipset Driver > Yes.
 Yes > Next > Next.
 to restart the computer.

ll Video Driver > Yes.
 Install (button).
press (or Custom if you prefer to 
figure the driver installation set-

 and click Next.
t (button) and click Yes.
 > Yes to restart the computer.

lling the video driver go to the Dis-
trol panel to adjust the video settings
solution (see “Video Features” on
ew Hardware Found
 you see the message “New Hardware Found” dur-
g the installation procedure (other than when out-
ned in the driver install procedure), click Cancel
 close the window, and follow the installation proce-

ure.

Driver Install
Insert the Device 
disc and click Ins

Chipset
1. Click 1.Insta
2. Click Next >
3. Click Finish

Video
1. Click 2.Insta
2. Click Next >
3. Click the Ex

manually con
tings) button

4. Click Accep
5. Click Finish

Note: After insta
play Settings con
to the highest re
page 1 - 19).

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
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ll Touchpad Driver > Yes.

ton to accept the license, and then 

 > Restart Now to restart the com-

ll CardReader Driver > Yes.
.
.

ll Hotkey Driver > Yes. 
 Install.
 > Finish to restart the computer.
Drivers & Utilities

- 6 Driver Installation

udio
. Click 3.Install Audio Driver > Yes. 
. Click Next.
. Click Finish to restart the computer.

odem
. Click 4.Install Modem Driver > Yes.
. Click OK.
. The modem is ready for dial-up configuration.

AN
. Click 5.Install LAN Driver > Yes. 
. Click Install.
. Click Finish.
. The network settings can now be configured.

TouchPad
1. Click 6.Insta
2. Click Next.
3. Click the but

click Next.
4. Click Finish

puter.

CardReader
1. Click 7.Insta
2. Click Install
3. Click Finish

Hot Key
1. Click 8.Insta
2. Click Next >
3. Click Finish

Modem Country Selection

Go to the Phone and Modem Options control panel (Hard-
ware and Sound) and make sure the modem country selection
is appropriate for you.
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4

ers
icated for the driver installation pro-
odules included in your purchase op-

vers Installer - Option Drivers Menu
Optional Driv
See the pages ind
cedures for any m
tion.

Figure 4 - 3 - Dri

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point 
to Settings and click Control Panel).

2. Click Check for updates (Security), or 
double-click Security Center and click 
Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates 

(you need to be connected to the internet).
5. Click Install now (button) to install the 

updates.
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tion in “3.75G/HSPA Module” on
heck the installation procedure.

ader Module
on in “Fingerprint Reader Module”
d check the installation procedure.
Drivers & Utilities

- 8 Driver Installation

luetooth Module
ote: The operating system is the default setting for
luetooth control in Windows Vista, and does not re-
uire a driver. See “Bluetooth Module” on page 7 - 2
r configuration instructions.

ireless LAN Module
ee the introduction in “Wireless LAN Module” on
age 7 - 7, and check the installation procedure.

C Camera Module
ee the introduction in “PC Camera Module” on
age 7 - 25, and check the installation procedure.

3.75G/HSPA M
See the introduc
page 7 - 33, and c

Fingerprint Re
See the introducti
on page 7 - 51, an
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BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
hapter 5: BIOS Utilities
verview

his chapter gives a brief introduction to the computer’s built-in software:

iagnostics: The POST (Power-On Self Test)

onfiguration: The Setup utility 
 your computer has never been set up, or you are making important chang
stem (e.g. hard disk setup), then you should review this chapter first and

riginal settings found in Setup. Even if you are a beginner, keep a record o
ngs you find and any changes you make. This information could be usefu
stem ever needs servicing.

here is one general rule: Don’t make any changes unless you are sure of w
re doing. Many of the settings are required by the system, and changing the
use it to become unstable or worse. If you have any doubts, consult you
presentative.
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OST)
m takes a few seconds to conduct a
AM (memory).

ou if there is anything wrong. If there
ing, it will display a system summary

l disappear and the system will load
’t get into Setup without rebooting.

2

BIOS Utilities

- 2 The Power-On Self Test (POST)

The Power-On Self Test (P
Each time you turn on the computer, the syste
POST, including a quick test of the on-board R

As the POST proceeds, the computer will tell y
is a problem that prevents the system from boot
and prompt you to run Setup. 

If there are no problems, the Setup prompt wil
the operating system. Once that starts, you can

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

1

3

4
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The Pow

ailing the POST
rrors can be detected during the POST. There are two categories, “fatal” a
tal”.

atal Errors
hese stop the boot process and usually indicate there is something serious
ith your system. Take the computer to your service representative or au
rvice center as soon as possible.

on-Fatal Errors
his kind of error still allows you to boot. You will get a message identif
roblem (make a note of this message!) followed by the prompt:

Press <F1> to resume
<F2> to enter Setup 

ress F1 to see if the boot process can continue. It may work, without th
nfiguration. 

ress F2 to run the Setup program and try to correct the problem. If you st
ror message after you change the setting, or if the “cure” seems even wo
r help.
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w to configure itself and manage ba-
tion).

s F2 during the POST. The prompt
is usually present for a few seconds
yboard Error”, (usually because you

trl + Alt + Delete combination and
 main menu will appear.
BIOS Utilities

- 4 The Setup Program

The Setup Program
The Phoenix Setup program tells the system ho
sic features and subsystems (e.g. port configura

Entering Setup
To enter Setup, turn on the computer and pres
(Press F2 to Enter Setup) seen on page 5 - 2 
after you turn on the system. If you get a “Ke
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the C
then hold down F2 when prompted. The Setup
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Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
etup Screens
he following pages contain additional advice on portions of the Setup.

long the top of the screen is a menu bar with menu headings. When you
eading, a new screen appears. Scroll through the features listed on each 
ake changes to Setup.

structions on how to navigate each screen are in the box along the botto
reen. If these tools are confusing, press F1 to call up a General Help scr
en use the arrow keys to scroll up or down the page.

he Item Specific Help on the right side of each screen explains the hig
em and has useful messages about its options.

 you see an arrow  next to an item, press Enter to go to a sub-menu on 
ct. The sub-menu screen that appears has a similar layout, but the Enter 
ecute a command.
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 ØØ = midnight; 13 = 1 pm). If you
erating system, you will also change
r data files to reflect these changes.
BIOS Utilities

- 6 Main Menu

Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e.,
can change the date and time settings in your op
these settings. Some applications may also alte

Figure 5 - 2
Main Menu
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T igurable.
T
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T he Video
B

ATA Port 1/2/5 (Main Menu)
ressing Enter opens the sub-menu to show the configuration of an HDD/op
ice on the computer’s SATA Port 1/2/5. Use the Auto (Type:) setting to 
ems configured automatically for you.

ystem Memory (Main Menu)
his item contains information on the system memory, and is not user conf
he system will auto detect the amount of memory installed.

IOS Revision/KBC/EC Firmware Revision (Main Menu)
his item contains information on the current BIOS and firmware versions

GA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
his item contains information on the current videos card installed, and on t
IOS version.
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- 8 Advanced Menu

Advanced Menu

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the suppo
non-USB aware operating systems.

Figure 5 - 3
Advanced Menu
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B
U ower-On
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L
E ows Vis-
ta irmware
In

B
U ttery has
re
oot-time Diagnostic Screen (Advanced Menu)
se this menu item to enable/disable the Boot-time Diagnostic Screen or P
elf Test (see “The Power-On Self Test (POST)” on page 5 - 2).

egacy OS Boot: (Advanced Menu)
nable this item to support only system boot from the Legacy OS (e.g Wind
). If disabled the system will attempt to boot from the EFI (Extensible F
terface) before the Legacy OS.

attery Low Alarm Beep (Advanced Menu)
se this menu item to enable/disable the audible warning when the ba
ached low power status.
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ixBIOS Setup Utility. This will not
oenixBIOS Setup Utility).
BIOS Utilities

- 10 Security Menu

Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoen
affect access to the computer OS, (only the Ph

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu
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o nabled”
is  (see the
w

N ord, then
p d Enter
ag

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
et User Password (Security Menu)
ou can set a password for user mode access to the PhoenixBIOS Setup
his will not affect access to the computer OS, (only the Setup utility) un
oose to set a Password on Boot (see below). Many menu items in the P

IOS Setup Utility cannot be modified in user mode. You can only set
assword after you have set the supervisor password.

ixed disk boot sector: (Security Menu)
 you choose “Write-Protect” this will protect against viruses being writt
ard disk boot sector (this is not a substitute for installing an anti-virus prog
Viruses” on page 8 - 4).

assword on boot: (Security Menu)
pecify whether or not a password should be entered to boot the computer (
nly set a password on boot if a supervisor password is enabled). If “E
 selected, only users who enter a correct password can boot the system
arning in the sidebar). The default setting is “Disabled”. 

ote: To clear existing passwords press Enter and type the existing passw
ress Enter for the new password (without typing any password entry) an
ain to confirm the password clearance.
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r an operating system (e.g. Windows
d in this priority order. If it cannot
 try to load it from the next device in
r. Item specific help on the right is
n the order.
BIOS Utilities

- 12 Boot Menu

Boot Menu

When you turn the computer on it will look fo
Vista) from the devices listed in this menu, an
find the operating system on that device, it will
the order specified in the Boot priority orde
available to help you move devices up and dow

Figure 5 - 5
Boot Menu
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Figure 5 - 6
Exit Menu
xit Menu

hoosing to Discard Changes, or Exit Discarding Changes, will wipe
anges you have made to the Setup. You can also choose to restore the orig

p defaults that will return the Setup to its original state, and erase any 
anges you have made in a previous session.
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6

C ter
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T teps out-
li  can con-
ta  need:
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•
•

B antistatic
w  compo-
n

T

•
•
•
•

P it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
hapter 6: Upgrading The Compu
verview

his chapter contains information on upgrading the computer. Follow the s
ned to make the desired upgrades. If you have any trouble or problems you
ct your service representative for further help. Before you begin you will

A small crosshead or Phillips screwdriver
A small regular slotted (flathead) screwdriver
An antistatic wrist strap

efore working with the internal components you will need to wear an 
rist strap to ground yourself because static electricity may damage the
ents.

he chapter includes:

Removing the Battery
Upgrading the Hard Disk Drive
Upgrading the Optical (CD/DVD) Device
Upgrading the System Memory (RAM)

lease make sure that you review each procedure before you perform 
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6

 case, adding and sometimes replac-

 if:

ice contract
 

vice representative to purchase or re-

ing the existing processor with a fast-
mer service representative. We rec-

ce if it is done incorrectly you may

ing

urposes of device upgrade, remember
 the computer on.
Upgrading The Computer

- 2 Overview

When Not to Upgrade
These procedures involve opening the system’s
ing parts.

You should not perform any of these upgrades

• Your system is still under warranty or a serv
• You don’t have all the necessary equipment
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your ser
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replac
er/new one you will need to contact your custo
ommend that you do not do this yourself, sin
damage the processor or mainboard.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warn

When removing any cover(s) and screw(s) for the p
to replace the cover(s) and screw(s) before turning
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6

R
If  reasons
it
1
2
3
4

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal
emoving the Battery
 you are confident in undertaking upgrade procedures yourself, for safety
 is best to remove the battery.
. Turn the computer off, and turn it over.
. Slide the latch  in the direction of the arrow.
. Slide the latch  in the direction of the arrow, and hold it in place.
. Slide the battery out in the direction of the arrow .

1
2

3

1

3

2
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rive
odate other 2.5" serial (SATA) hard

torage” on page C - 2). Follow your
 install all necessary drivers and util-
 when setting up a new hard disk.

emove the battery.
crews  & .1 2

Model B

21

3

Upgrading The Computer

- 4 Upgrading the Hard Disk Drive

Upgrading the Hard Disk D
The hard disk drive can be taken out to accomm
disk drives with a height of 9.5mm (h) (see “S
operating system’s installation instructions, and
ities (see “Driver Installation” on page 4 - 2),

1. Turn off the computer, and turn it over and r
2. Locate the hard disk bay cover and loosen s
3. Remove the hard disk bay cover .

HDD System 
Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay 
Cover Removal

3

Model A

21

3
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6

4
5

Figure 6 - 3
HDD Assembly 

Removal
Upgrad

. Grip the tab and slide the hard disk in the direction of arrow .

. Lift the hard disk out of the bay .
4

5

4
5

4

5

Model B

Model A
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 and the adhesive cover .
k drive (do not forget to replace all the 

7

Hard Disk Screws & 
Cover

The hard disks and cov-
ers pictured here may
appear slightly different
from your model design
(these designs are sub-
ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.
Upgrading The Computer

- 6 Upgrading the Hard Disk Drive

6. Remove the screw(s)  (for Model B only)
7. Reverse the process to install a new hard dis

screws and covers).

Figure 6 - 4
HDD Cover 

Removal

6

7

6

7

Model B

Model A
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ptical (CD/DVD) Device 6 - 7

6

U
1
2
3

Figure 6 - 5
Removing the HDD 

Cover
Upgrading the O

pgrading the Optical (CD/DVD) Device
. Turn off the computer, and turn it over and remove the battery.
. Locate the hard disk bay cover and loosen screws  & .
. Remove the hard disk bay cover .

1 2
3

Model BModel A

21

3

21

3
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rewdriver to carefully push out the 

e.

6

7

Upgrading The Computer

- 8 Upgrading the Optical (CD/DVD) Device

4. Remove the screw at point , and use a sc
optical device at point .

5. Reverse the process to install the new devic

Figure 6 - 6
Removing the 
Optical Device

6
7

7
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System Memory (RAM) 6 - 9

6

U
T ine (SO-
D C - 2 for
d

1
2

Figure 6 - 7
CPU/RAM Bay 
Cover Screws
Upgrading the 

pgrading the System Memory (RAM)
he computer has two memory sockets for 204 pin Small Outline Dual In-l
IMM) DDRIII (DDR3) type memory modules (see “Memory” on page
etails of supported module types).

. Turn off the computer, and turn it over and remove the battery.

. Locate the RAM & CPU bay cover and remove screws  - .1 3

1

2

3

3
1

2
Model A Model B
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the under side of the cover) lift up 

emove the cover .5

5

4

5

4

Model B

Model A
Upgrading The Computer

- 10 Upgrading the System Memory (RAM)

3. Carefully (a fan and cable are attached to 
the bay cover.

4. Carefully disconnect the fan cable , and r
Fan Cable & Cover

Make sure you recon-
nect the fan cable 
before screwing down
the bay cover. Note the
information on replacing
the RAM & CPU bay
cover in “Cover Pins”
on page 6 - 12.

Contact Warning

Be careful not to touch
the metal pins on the
RAM module’s connect-
ing edge. Even the
cleanest hands have
oils which can attract
particles, and degrade
the module’s perfor-
mance.

Figure 6 - 8
CPU/RAM Bay 

Cover Removed

4

4
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6

5 he 

6
7
8  firmly 

9  module 
hould fit 

Figure 6 - 9
RAM Module 

Removal

Single Memory 
Module Installation

If your computer has a
single memory module,
then insert the module
into the Channel 0
(JDIMM1) socket. In this
case this is the lower
memory socket (the
socket closest to the
mainboard).
Upgrading the S

. Gently pull the two release latches on the sides of the memory socket in t
direction indicated by the arrows (  & ) in Figure 6 - 9.

. The RAM module will  pop-up, and you can remove it.

. Pull the latches to release the second module if necessary.

. Insert a new module holding it at about a 30° angle and fit the connectors
into the memory slot.

. The module’s pin alignment will allow it to only fit one way. Make sure the
is seated as far into the slot as it will go. DO NOT FORCE the module; it s
without much pressure.

6 7
8

6
8

7
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ainboard until the slot levers click into 

w for Model A Computers) and 
cable before screwing down the 

gister the new memory configuration 

Model B
Upgrading The Computer

- 12 Upgrading the System Memory (RAM)

10. Press the module in and down towards the m
place to secure the module.

11. Replace the bay cover (see sidebar and belo
screws (make sure you reconnect the fan 
bay cover).

12. Restart the computer to allow the BIOS to re
as it starts up.

Cover Pins

Note that there are cov-
er pins need to be
aligned with slots in the
case to insure a proper
cover fit, before screw-
ing down the bay cover
(see Figure 6 - 10).

Figure 6 - 10
Cover Pin 
Alignment

Model A



Modules & Options

Overview 7 - 1

7

C
O
T me with
y re please
co

•
•
•
•
•

Wireless Device 
Operation Aboard   

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Important Notice

If your purchase option in-
cludes both Wireless LAN
and 3.75G/HSPA modules,
then the appropriate anten-
nas will be installed. Note
that In order to comply with
FCC RF exposure compli-
ance requirements, the an-
tenna must not be co-
located or operate in con-
junction with any other an-
tenna or transmitter.

s

odule
dio fre-
e sure
hapter 7: Modules & Options
verview

his chapter contains information on the following modules, which may co
our computer, depending on the configuration purchased. If you are unsu
ntact your service representative.

Bluetooth Module
Wireless LAN Module
PC Camera Module
3.75G/HSPA Module
Fingerprint Reader Module

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Module

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA m
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt ra
quency, and cause interference. When the 3.75G/HSPA module is powered on, mak
that the Bluetooth/Wireless LAN modules are powered off.
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ntrol panel is used to configure the
efore does not require a driver. Use
n/Hot Key Indicators” on page 1 -

 When the Bluetooth module is pow-
-screen indicator will briefly be dis-

ransfer

 and a Bluetooth enabled device is sup-
 transfer is not supported). Therefore
uetooth enabled device, you will not be
e to your computer until the file transfer

g From Sleep Mode

 resuming from the Sleep power-saving
 on the Bluetooth module after the com-
Modules & Options

- 2 Bluetooth Module

Bluetooth Module
The operating system’s Bluetooth Devices co
Bluetooth settings in Windows Vista, and ther
the Fn + F12 key combination (see “Functio
13) to toggle power to the Bluetooth module.
ered on, the  LED will be orange and the on
played.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 13/ Table 1
- 4, on page 1 - 9).

Bluetooth Data T

Note that the transfer of data between the computer
ported in one direction only (simultaneous data
if you are copying a file from your computer to a Bl
able to copy a file from the Bluetooth enabled devic
process from the computer has been completed.

Bluetooth Module & Resumin

The Bluetooth module’s default state will be off after
state. Use the key combination (Fn + F12) to power
puter resumes from Sleep.
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Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the task-
bar, access the Blue-
tooth Devices control
panel. Click Bluetooth
Settings > Options, and
make sure that Show the
Bluetooth icon in the
notification area check
box (Connections) has a
tick inside it.

Note that you will need to
check the LED indicator
to see if the module is
powered on or not.

Figure 7 - 1
Bluetooth Devices & 

Click Icon Menu
luetooth Configuration in Windows Vista
etup your Bluetooth Device so the Computer Can Find it
. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
. Make the device discoverable (to do this check your device documentatio

o Turn the Bluetooth Module On
. Press the Fn + F12 key combination to power on the Bluetooth module. 
. A Bluetooth icon  will appear in the taskbar (see sidebar).
. You can then do any of the following to access the Bluetooth Devices co

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), a

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth SettingsAdd Wireless Device
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l and click Bluetooth Settings.
w Bluetooth devices to connect to 
s a tick inside it, and click OK.
 Devices control panel.
 the computer.

 you with a pairing code to be entered 
Modules & Options

- 4 Bluetooth Module

To Add a Bluetooth Device
1. Access the Bluetooth Devices control pane
2. Click Options (tab), and make sure that Allo

this computer check box (Connections) ha
3. Click Add Wireless Device in the Bluetooth
4. Double-click the device you want to pair with

5. On first connection the computer will provide
onto the device.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 2
Pair with a wireless 

device
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7

6 en 

7 ring. 
8 quired to 

9

Figure 7 - 3
Pairing Code 

Example

Figure 7 - 4
Pairing Complete & 
Bluetooth Device 

Enabled

tion to
uters,

proce-
airing
e on-
. Enter the code into your Bluetooth enabled device and follow any on-scre
instructions to complete the pairing.

. Windows will check to see if any drivers are required to complete the pai

. Follow any on-screen instructions on the computer if device drivers are re
be installed.

. Click Close.

Pairing Codes

The example outlined here shows a connec
a mobile device. Other devices e.g. comp
may have a slightly different connection 
dure, and may require you to confirm a p
code is correct on both devices. Follow th
screen instructions to complete the pairing.
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ice
l.
click Properties to:
ype a new name and click OK).
k the check box next to the service and click OK).

Bluetooth Devices
l.
ake sure that Allow Bluetooth 
iscovery) has a tick inside it.

luetooth device wants to connect 
t, if you want to be notified when a 
Modules & Options

- 6 Bluetooth Module

To Change Settings for the Bluetooth Dev
1. Access the Bluetooth Devices control pane
2. Click on the device you want to change and 

• Change the name of the device (click General, t
• Enable/Disable a service (click Services, clear/tic

To Make your Computer Discoverable to 
1. Access the Bluetooth Devices control pane
2. Click Bluetooth Settings > Options, and m

devices to find this computer check box (D
3. Make sure that the Alert me when a new B

check box (Connections) has a tick inside i
Bluetooth device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 5
Bluetooth Settings - 

Options
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T s module
is s part of
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o  page 7 -
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If and wish
to stall the
d  installa-
ti  and then
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Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 6, on
page 1 - 13/ Table 1 - 4, on
page 1 - 9).
ireless LAN Module
 you have included an Intel® Wi-Fi Link 5300 Series, Intel® Advanced
ink 6200, Intel® Ultimate N Wi-Fi Link 6300, 3rd Party 802.11b/g or 3
02.11b/g/n WLAN module in your purchase option, make sure that the 
AN module is on before installing the driver.

se the Fn + F11 key combination (see “Function/Hot Key Indicators” o
13) to toggle power to the Wireless LAN module. When the WLAN m
owered on, the  LED will be green and the on-screen indicator will brief
layed. Make sure you install the drivers in the order indicated in Table 4
age 4 - 3.

he standard driver installation procedure for the Intel® Wi-Fi Link Serie
 outlined overleaf. If you want to include Intel® My WiFi Technology a
e installation procedure, DO NOT install the driver as per the inst

verleaf, instead see “Intel® My WiFi Installation & Configuration” on
2.

 you have installed the standard driver (as per the instructions overleaf) 
 enable Intel® My WiFi Technology at a later point you will need to rein

river (choose Unlock from the Drivers Installer menu). Follow the driver
on procedure and choose Modify from the menu when the option appears,
llow the remaining installation instructions in “Intel® My WiFi Instal
onfiguration” on page 7 - 12.
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tion
e” click Cancel to close the window.
n insert the Device Drivers & Util-
VD drive. 

 click Next.

Driver Installation
n insert the Device Drivers & Util-
VD drive. 

 Next.

g for Wireless LAN control in Win-
Modules & Options

- 8 Wireless LAN Module

Intel® Wi-Fi Link Series Driver Installa
If you see the message “Found New Hardwar
1. Make sure the module is powered on, the

ities + User’s Manual disc into the CD/D
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and
6. Click Next > Next > Finish.

3rd Party 802.11b/g/n or 802.11b/g/n 
1. Make sure the module is powered on, the

ities + User’s Manual disc into the CD/D
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click
5. Click Next > Install.
6. Click Finish.

Note: The operating system is the default settin
dows Vista (see overleaf).

Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).
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1 (or right-

2
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Figure 7 - 6
Taskbar Menus

Network and 
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 7
Connect to a 

Network
onnecting to a Wireless Network
ake sure the Wireless LAN module is turned on.

. Click the taskbar wireless icon , and then click Connect to a network 
click the icon , and then click Connect to a network).

. In the Show list, click to choose Wireless from the drop-down menu.

. A list of currently available networks will appear.

Click icon Right-click icon
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7

ect to, click Set up a connection or 
g manual searching, and creating a 

ee the connection status (see below).
Modules & Options

- 10 Wireless LAN Module

4. Click a network, and then click Connect.
5. If you do not see a network you want to conn

network (a list of options will appear allowin
new network).

6. Move the cursor over the taskbar icon  to s

Figure 7 - 8
Connecting

Figure 7 - 9
Connection Status
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7  icon , 
d click 

Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 10
Disconnecting
. To disconnect from the wireless network you can click the taskbar wireless
and then select Connect or disconnect to access the network menu, an
Disconnect (or right-click the icon , and then click Disconnect from).

Click icon

Right-click icon
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iguration
 module to allow you to connect up
ital cameras, other computers, cell

ter (similar to Bluetooth), while still
ireless connection. Intel® My WiFi
n other personal area networks, and
Modules & Options

- 12 Wireless LAN Module

Intel® My WiFi Installation & Conf
Intel® My WiFi Technology uses your WLAN
to eight other WiFi enabled devices (e.g. dig
phones, handheld devices etc.) to your compu
connecting to the Internet through your WiFi w
Technology offers greater range and speed tha
does not require an access point.

Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel
PROSet Wireless > Intel
My WiFi Technology), or
by clicking the taskbar
icon . Click the Help
icon  and select
a help topic from the
Contents menu.
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Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).

Figure 7 - 11
Intel(R) PRO Set
Intel(R) My WiFi 

Technology 
Installation
tel® Wi-Fi Link Series My WiFi Driver Installation
 you see the message “Found New Hardware” click Cancel to close the 
. Make sure the module is powered on, then insert the Device Drivers

ities + User’s Manual disc into the CD/DVD drive. 
. Click Option Drivers (button).
. Click 1.Install WLAN Driver > Yes.
. Click Next > Next.
. Click the button to accept the license and click Next > Next.
. Click Custom (button) and click Next.
. Click Intel(R) My WiFi Technology (button) and select “This feat

be installed on local hard drive.”

. Click Next > Finish.
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7

lows.

tart menu (Start > Programs/All 
 My WiFi Technology), or by clicking 

 program there will be no connected 
Modules & Options

- 14 Wireless LAN Module

Intel® My WiFi Configuration
You can configure the My WiFi settings as fol

1. Access the Intel® My WiFi Utility from the S
Programs > Intel PROSet Wireless > Intel
the taskbar icon .

2. Click Enable  (on the first run of the
devices listed).

Figure 7 - 12
Intel® My WiFi 

Utility
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Figure 7 - 13
Network and 

Sharing Center

Figure 7 - 14
Intel WiFi STA 

Properties 
(Network 

Connections)
. Click Start, and click Control Panel (or point to Settings and click Contr
Panel).

. Click Network and Sharing Center (Network and Internet). 

. Click Manage Network Connections. 

. Right-click Intel WiFi STA (Station) in Network Connections and select 
Properties.

Click Manage Network
Connections 

Right-click Intel WiFi STA
(Station) and select Prop-
erties. 
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 network users to connect through 

orking Connection.
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7. Click Sharing (tab) and select “Allow other
this computer’s Internet connection”.

8. Select Intel My WiFi PAN under Home Netw
9. Click OK.

Figure 7 - 15
Intel WiFi STA 

Properties - 
Sharing

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Intel My WiFi PAN.
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1 s/All 
 clicking 
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Figure 7 - 16
IP Address 

Warning

IP Addresses

The Intel® My WiFi de-
fault gateway IP ad-
dress is 192.168.0.1.
DO NOT use this ad-
dress for any Wireless
Access Point (or any
other static IP address
on your network).

Figure 7 - 17
Intel® My WiFi 

Utility
0. A message will appear to inform you that the LAN adapter will be set to us
address 192.168.0.1.

. Click Yes to enable Internet Connection Sharing.

2. Access the Intel® My WiFi Utility from the Start menu (Start > Program
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by
the taskbar icon .

3. Click Profiles .
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 click Edit.

ork Name to your personal 
Modules & Options

- 18 Wireless LAN Module

14. Click Profiles, click Intel Wireless PAN and

15. You can change the Profile Name and Netw
preferences in General (tab).

Figure 7 - 18
Profiles

Figure 7 - 19
Intel® My WiFi 

Profile Settings - 
General

Profile and Network Names

The Profile Name is the name as
displayed on your computer in the
Network Connections control pan-
el (see Figure 7 - 14 on page 7 -
15).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.
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Figure 7 - 20
Intel® My WiFi 

Profile Settings - 
Security
6. Click Security (tab).
7. Change the Security Type to WEP and the Encryption Type to 64bit.
8. Enter a password (5 characters long) in the Passphrase box. 
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 and DNS Server are Disabled. 
Modules & Options
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19. Click Sharing (tab).
20. Make sure Filter Network Traffic and DHCP

Figure 7 - 21
Intel® My WiFi 

Profile Settings - 
Sharing

Set Filter Network
Traffic & DHCP
and DNS Servers
to Disabled.
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Figure 7 - 22
Intel® My WiFi 

Profile Settings - 
Advanced
1. Click Advanced (tab).
2. Make sure the Default Channel is set to Channel 1, 6 or 11.
3. Click OK to save all the settings and click Close to exit Profiles. 
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a Network) in Network Connections.
tion Details.
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24. Double-click Intel My WiFi PAN (Personal Are
25. Click Details to display the Network Connec

Figure 7 - 23
Intel My WiFi PAN 

Network 
Connection Details 

(Network 
Connections)
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Figure 7 - 24
Intel® My WiFi 

Utility 
(Add New Device)
6. Access the Intel® My WiFi Utility from the Start menu (Start > Program
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by
the taskbar icon .

7. To add a new device follow the instructions in the devices’ user guide for 
connecting to a WiFi network.

8. Click Add New Device in Intel® My WiFi Utility to confirm the security s
detail.
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provides an easy point of access for
 and wireless device status etc.

t to Settings and click Control 

bile PC).
lick the icon  to access the network 
Modules & Options
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Windows Mobility Center
The Windows Mobility Center control panel 
information on battery status, power plans used

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or poin

Panel).
2. Double-click Windows Mobility Center (Mo
3. Click the button to Turn wireless off/on, or c

menu.

Figure 7 - 25
Windows Mobility 

Center
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F  - 13) to
to powered
o the driv-
er

Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.
C Camera Module
ake sure that the PC Camera module is on before installing the driver and

n + F10 key combination (see “Function/Hot Key Indicators” on page 1
ggle power to the PC Camera module. When the PC Camera module is 

n, the on-screen indicator will briefly be displayed. Make sure you install 
s in the order indicated in Table 4 - 1, on page 4 - 3.



7

7

n insert the Device Drivers & Util-
VD drive. 

 Next > Next.

rom the BisonCam shortcut on the 
he Start > Programs/All Pro-
ff use the Fn + F10 key combina-
Modules & Options
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PC Camera Driver Installation
1. Make sure the module is powered on, the

ities + User’s Manual disc into the CD/D
2. Click Option Drivers (button).
3. Click 2.Install Camera Driver > Yes.
4. Choose the language you prefer and click
5. Click Finish to restart the computer.
6. Run the BisonCap application program f

desktop, or from the BisonCam item in t
grams menu (if the hardware is turned o
tion to turn it on again).

PC Camera Screen 
Refresh

If you find that the
screen refresh rate is
subject to lag or stutter-
ing, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion. 

To reduce Output Size
and/or Color Space
Compression run the
BisonCap application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate pull-down
menu.
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9  should 

1 ve a tick 
C Camera Audio Setup
 you wish to capture video & audio with your camera, it is necessary to 
dio recording options in Windows.

. Click Start, and click Control Panel (or point to Settings and click Contro

. Double-click Sound  (Hardware and Sound).

. Click Recording (tab).

. Right-click Microphone (Realtek High Definition Audio) and make sure th
not disabled.

. Double-click Microphone (or select Properties from the right-click menu

. Click Levels (tab), and adjust the Microphone and Microphone Boost s
the level required.

. Click OK and close the control panels.

. Run the BisonCap application program from the Start > Programs/All Pr
> BisonCam menu.

. Go to the Devices menu heading and select Microphone (Realtek....) (it
have a tick alongside it).

0. Go to the Capture menu heading and select Capture Audio (it should ha
alongside it).
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Figure 7 - 26
Audio Setup for PC 

Camera

Right-click
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Pre-Allocating File 
Space

You may pre-allocate the
file size (File > Allocate
File Space) for the cap-
ture file in the BisonCap
program.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
30.
isonCap
isonCap is a video viewer for general purpose video viewing and testing
pturing video files to .avi format.

. Run the BisonCap program from the Start > Programs/All Programs > 
Cam menu (it is recommended that you set the capture file before the c
process - see Set Capture File below).

. Go to the Capture menu heading (if you wish to capture audio check “PC 
Audio Setup” on page 7 - 27) and select Start Capture.

. Click OK (the file location will be displayed in the pop-up box) to start capt
video, and press Esc to stop the capture (you can view the file using the W
Media Player).

et Capture File
rior to capturing video files you may select the Set Capture File... opti
ile menu, and set the file name and location before capture (this will help a
dentally overwriting files). Set the name and location then click Open, the
Capture file size:” and click OK. You can then start the capture process a

ote the important information in “Reducing Video File Size” on page
rder to save file space, and help prevent system problems.
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requires a substantial amount of disk
ck the video file size (right-click the
ee space on your hard disk (go to My
t Properties). If necessary you can
edium e.g. CD, DVD or USB Flash

 minimum of 15GB of free space on
nt system problems it is recommend-
tion other than the C: drive (see “Set
ize of the captured video (see “Pre-
ce video resolution (see below).

eo Capture Pin....
 lower resolution size in order to 
Modules & Options

- 30 PC Camera Module

Reducing Video File Size
Note that capturing high resolution video files 
space for each file. After recording video, che
file and select Properties) and the remaining fr
Computer, right-click the hard disk, and selec
remove the recorded video file to a removable m
drive.

Note that the Windows Vista system requires a
the C: drive system partition. In order to preve
ed that you save the captured video file to a loca
Capture File” on page 7 - 29), limit the file s
Allocating File Space” on page 7 - 29) or redu

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Vid
3. Click the Output Size drop box and select a

reduce the captured file size.
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Figure 7 - 27
Video Capture Filter
liminating Screen Flicker
 you find that the video screen in the BisonCap program is flickering, yo
 adjust the setting in the Video Capture Filter options.

. Run the BisonCap program.

. Go to Options and scroll down to select Video Capture Filter....

. Click either 50Hz or 60Hz under Frequency in Property Page (tab).



7

7

e camera in and out.

.

l pictures.

n the Snapshot folder  on the 
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Zoom
The BisonCap program allows you to zoom th

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In

Taking Still Pictures
The BisonCap program allows you to take stil

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed i

desktop.

Figure 7 - 28
Zoom/Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.



Modules & Options

3.75G/HSPA Module 7 - 33

7

3
If ) module
(s hase op-
ti r Mobile
P page 7 -
3 stall the
ap

3.75G/HSPA Module 
Options

There are two optional
3.75G/HSPA modules
available for this series of
computer models. Each
module is supplied with the
appropriate application
software.

The module type supplied
may depend upon the com-
puter model purchased.
Check with your service
center for details.

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.

s

odule
dio fre-
e sure
.75G/HSPA Module
 you have included an optional 3.75G/HSPA (High Speed Packet Access
ee “Communication” on page C - 3 for specification details) in your purc
on, you will have the appropriate application (HSPA Modem Interface o
artner) provided for your particular module. Follow the instructions on 
5 to install the USIM card (supplied by your service provider), and then in
plication (see over for further details).

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Module

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA m
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt ra
quency, and cause interference. When the 3.75G/HSPA module is powered on, mak
that the Bluetooth/Wireless LAN modules are powered off.
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hat the 3.75G/HSPA module is ON
not allow the software to detect the
ey combination (see “Function/Hot
ower to the 3.75G/HSPA module.
the on-screen indicator will briefly be
he order indicated in Table 4 - 1, on
oes NOT turn off the 3.75G/HSPA

dem Interface Installation” on 
n and “HSPA Modem Interface” 
HSPA Modem Interface.

lication Installation” on page 7 - 
obile Partner Application” on 

bile Partner application.
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Before installing the application, make sure t
(installing the driver with the module off will 
module hardware correctly). Use the Fn +  k
Key Indicators” on page 1 - 13) to toggle p
When the 3.75G/HSPA module is powered on, 
displayed. Make sure you install the drivers in t
page 4 - 3. Note that exiting the application d
module.

• HSPA Modem Interface - See “HSPA Mo
page 7 - 37 for driver installation informatio
on page 7 - 38 for instructions on using the 

• Mobile Partner - See “Mobile Partner App
46 for driver installation information and “M
page 7 - 47 for instructions on using the Mo

3.75G/HSPA 
Modules & System 

Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.
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Power Safety 
Warning

Before you undertake
any installation proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Figure 7 - 29
SIM Card Cover/

RAM & CPU 
Bay Cover Removal

le

ou re-
n cable
rewing
cover.
or Model A
. Turn off the computer, and turn it over and remove the battery.
. Locate the SIM card cover and loosen screw .
. Remove the SIM card cover .

or Model B
. Turn off the computer, and turn it over and remove the battery.
. Locate the RAM & CPU bay cover and remove screws  - .
. Carefully (a fan and cable are attached to the under side of the cover

the bay cover.
. Carefully disconnect the fan cable , and remove the cover . 

1
2

3 5

6 7

2

1 Model B3

4

5

Model A

7

6

Fan Cab

Make sure y
connect the fa

 before sc
down the bay 
6
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 mobile phone.
 opposite direction to the arrow 

e the lock and lift it up.
 7 - 30) and close the SIMLOCK.

tion of the arrow in Figure 7 - 31 until 

he fan cable before screwing down 
 sidebar for note on cover pins).

 A

Model B
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5. Insert the USIM card as you would into your
6. Slide the SIMLOCK towards the hinge (in the

illustrated in Figure 7 - 31) in order to releas
7. Insert the USIM card as illustrated in (Figure

8. Lock the SIMLOCK by pushing it in the direc
it clicks into the lock position.

9. Replace the covers and screws (reconnect t
the bay cover for Model B computers - see

Figure 7 - 30
Insert the USIM 

Card

Figure 7 - 31
SIMLOCK Lock

Cover Pins

Note that Model B has
cover pins that need to be
aligned with slots in the
case to insure a proper
cover fit, before screwing
down the bay cover.

Model

Model A
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Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 13/ Table 1
- 4, on page 1 - 9).
SPA Modem Interface
ith the 3.75G/HSPA module and USIM card (supplied by your service p
stalled you may then install the HSPA Modem Interface. The HSPA Mo
rface allows you to directly access your HSPA internet service from the c

SPA Modem Interface Installation
. Enable power to the module by pressing the Fn +  key combinatio

the module about 10 seconds to power on and the on-screen icon w
cate the module’s power status). 

. If a Found New Hardware window appears, click Cancel in all wi
that appear, and then proceed to install the driver as below.

. Insert the Device Drivers & Utilities + User’s Manual disc into the
DVD drive.

. Click Option Drivers (button).

. Click 3.Install 3G Driver > Yes.

. Click Next > Install.

. Click Finish to restart the computer.

. Access the HSPA Modem Interface from the Start menu (Start >
grams/All Programs > HSPA modem), or by double-clicking the 
modem icon on the desktop.
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IM card supplied by the service pro-

e Fn +  key combination.
e Start menu (Start > Programs/All 
), or by double-clicking the desktop 

e will appear to notify you of this (click 
M card).
ssage will appear to prompt you to 
ettings  and click OK in PIN 

 and the HSPA Modem interface 

he USIM
our ser-

s, User-
nnection
r tab, or
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HSPA Modem Interface
The connection information is stored on the US
vider.

1. Power on the 3.75G/HSPA module using th
2. Access the HSPA Modem Interface from th

Programs > HSPA Modem > HSPA Modem
icon .

3. If a USIM card is not installed then a messag
OK to close the message and install the USI

4. If you are required to enter a pin # then a me
enter a pin #. (Note: to change pin # go to S
code.)

5. Click the Network connection  button
window will display Connection Manager.

HSPA Modem Help

To get help on 3.75G/
HSPA module configu-
ration and settings, click
the help icon  and
select Help.

Figure 7 - 32
HSPA Modem 

Interface Window

Connection Manager

The connection information is commonly stored on t
card supplied by the service provider. However if y
vice provider requires details such as IP Addres
name and Password etc. to be entered before co
you can enter them in the Connection Manage
save the details in Profiles.
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Figure 7 - 33
Connecting to 

Network

Figure 7 - 34
Network is 
Connected
. Click Connect  to connect to your service provider.

. The message “Network is connected” will be displayed when the netwo
connection is successful. 

. You can then access the internet, download e-mail etc. as per any interne
connection.
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er of the HSPA Modem interface will 
the taskbar icon will display the 

 icon (Connection Manager).
 provider.

 to press the Fn +  key combination 

e Start menu (Start > Programs/All 
), or by clicking the desktop icon.

ick Profiles (tab).
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9. While you are connected the upper right corn
display the upload and download rates, and 
connection speed.

10. To disconnect click the Disconnect 
11. The program will disconnect from the service
12. The module will still be on, and you will need

to turn it off.

Adding a Profile
1. Access the HSPA Modem Interface from th

Programs > HSPA Modem > HSPA Modem
2. Click the Network connection , and cl

Figure 7 - 35
Uploading/

Downloading Rates 
and Speed

Figure 7 - 36
Profiles
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Figure 7 - 37
Network Settings & 

Profiles
. Click Add (button) and input any Network Settings required by your serv
provider.

. Click OK to save the profile.

. You can Edit or Delete profiles from the Profiles tab.

. To use a profile click to select it, and then click Apply (button) and the set
be transferred to Connection Manager.
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e Start menu (Start > Programs/All 
), or by clicking the desktop icon.

cts from the USIM card to the 

ion (or right-click and select Edit).
king the appropriate button.
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Contacts
1. Access the HSPA Modem Interface from th

Programs > HSPA Modem > HSPA Modem
2. Click Contacts  (button).

3. Click Refresh (button) to download the conta
computer.

4. The Contacts will then be displayed.
5. Double-click any contact to edit the informat
6. You can also Export/Import contacts by clic

Figure 7 - 38
Network Settings & 

Profiles
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SMS Service

In addition to standard in-
ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.

Figure 7 - 39
Network Settings & 

Profiles
essages
. Access the HSPA Modem Interface from the Start menu (Start > Progra

Programs > HSPA Modem > HSPA Modem), or by clicking the desktop 
. Click Messages  (button).

. Click Refresh (button) to download the messages from the USIM card to 
computer.

. Click New (button) to create a new message.

. You can either type the telephone number in the recipient field, or press T
(button) to select the contact from the list.
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n click Add (button) and the phone 
cipient field.
age body and click Send (button) to 
 message.
 or to reply to it.

e Start menu (Start > Programs/All 
), or by clicking the desktop icon.
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6. Click to select a contact from the list and the
number will automatically be added to the re

7. Type the message information into the mess
send it, or Save to draft (button) to save the

8. Select any message to forward or delete it,

Settings
1. Access the HSPA Modem Interface from th

Programs > HSPA Modem > HSPA Modem
2. Click Settings  (button).

Figure 7 - 40
Settings
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7

3
4  card) or 

5 .

6 mber.
7 u will 

reful 
rd 

8 e power 
elow:

• started; 

• rnate; 

Figure 7 - 41 
Settings - Network/

Network Mode
. Click OK alongside any of the options to configure the settings.

. The Network can be configured for an Automatic (usually from the USIM
Manual connection.

. The Network Mode can be configured for any appropriate mode required

. You can also change your settings for the Pin #, and input your phone nu

. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and yo
need to press the Fn +  key combination to turn off the module (pay ca
attention to this aboard aircraft - see “Wireless Device Operation Aboa
Aircraft” on page 7 - 7).

. If the module is on and the computer enters a power-saving state, then th
status of the module on resuming from the power-saving state will be as b

If the 3.75G/HSPA module is on and the computer is Shut Down or Re
the module will be off when the computer starts up.
If the 3.75G/HSPA module is on and the computer enters Sleep or Hibe
the module will be off when the computer resumes from sleep.
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7

 (supplied by your service provider)
er application. The Mobile Partner
SPA internet service from the com-

n
the Fn +  key combination (give 
n and the on-screen icon will indi-

ars, click Cancel in all windows 
e driver as below.
ser’s Manual disc into the CD/

 OK.
se agreement.

rom the Start menu (Start > Pro-
), or by double-clicking the 
Modules & Options
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Mobile Partner
With the 3.75G/HSPA module and USIM card
installed you may then install the Mobile Partn
application allows you to directly access your H
puter.

Mobile Partner Application Installatio
1. Enable power to the module by pressing 

the module about 10 seconds to power o
cate the module’s power status). 

2. If a Found New Hardware window appe
that appear, and then proceed to install th

3. Insert the Device Drivers & Utilities + U
DVD drive.

4. Click Option Drivers (button).
5. Click 3.Install 3G Driver > Yes.
6. Choose the language you prefer and click
7. Click I Agree (button) to accept the licen
8. Click Next > Install.
9. Click Finish to restart the computer.
10. Access the Mobile Partner application f

grams/All Programs > Mobile Partner
Mobile Partner icon on the desktop.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 13/ Table 1
- 4, on page 1 - 9).
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7

M
Y  how ex-
ac

P
1
2 rams/

er icon 

3  click 

4 e, APN 

5

Mobile Partner Help

To get help on Mobile
Partner configuration
and settings, click the
Help menu and select
Online Help or press
F1.

Figure 7 - 42
Profile Management
obile Partner Application
ou will need to contact your service provider to obtain the exact details of
tly to configure the settings on this page.

rofile Management
. Power on the 3.75G/HSPA module using the Fn +  key combination.
. Access the Mobile Partner application from the Start menu (Start > Prog

All Programs > Mobile Partner), or by double-clicking the Mobile Partn
on the desktop .

. If you have not created a profile, click Tools and select Options, and then
Profile Management.

. Click New  and input the appropriate information for Profile Nam
and Authentication etc. as supplied by your service provider.

. Click Save  to save the profile.
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 Fn +  key combination.
 the Start menu (Start > Programs/
le-clicking the Mobile Partner icon 

 Profile Name from the menu.
ction process.

lay the connection information.
Modules & Options
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the
2. Access the Mobile Partner application from

All Programs > Mobile Partner), or by doub
on the desktop .

3. The software will run and you can select the
4. Click Connect  to begin the conne

5. The Mobile Partner application will then disp

Figure 7 - 43 
Connect

Figure 7 - 44
Network 

Connection Prompt
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7

6 ork icon 

7 t 

8 display 

9 bar icon 

1

Figure 7 - 45
Connected 

Taskbar 
Notification

Figure 7 - 46
Disconnect
. When the connection is successful you can move the cursor over the netw
in the taskbar to display the connection information.

. You can then access the internet, download e-mail etc. as per any interne
connection.

. While you are connected the indicators in the Mobile Partner window will 
uploading and downloading icons and a network icon in the taskbar .

. To disconnect click the Disconnect  icon, or right click the task
and select Disconnect.

0. The program will disconnect from the service provider.
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7

 to press the Fn +  key combination 

a message will be displayed asking 
nd to terminate the connection. 

n, but DOES NOT turn off the 3.75G/
e Fn +  key combination to turn off 
ard aircraft - see “Wireless Device 
).
a power-saving state, then the power 
ower-saving state will be as below:

puter is Shut Down or Restarted; 
tarts up.
mputer enters Sleep or Hibernate; 
esumes from sleep.
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11. The module will still be on, and you will need
to turn it off.

12. If you click the Mobile Partner close icon  
you to click OK to confirm the program exit a

13. Exiting the program terminates the connectio
HSPA module, and you will need to press th
the module (pay careful attention to this abo
Operation Aboard Aircraft” on page 7 - 46

14. If the module is on and the computer enters 
status of the module on resuming from the p

• If the 3.75G/HSPA module is on and the com
the module will be off when the computer s

• If the 3.75G/HSPA module is on and the co
the module will be off when the computer r

Figure 7 - 47
Exit Prompt
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F
T omputer.
M indows
p

B ough the
fi grams >
P

F
1  CD/

2
3
4
5
6

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 4.In-
stall FingerPrint Driver
>Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
Finge

ingerprint Reader Module
he fingerprint reader module provides a high level of security for your c
ake sure you have administrator’s rights to your computer, and have a W

assword enabled for full security protection.

efore beginning the enrollment process it is recommended that you go thr
ngerprint tutorial. To run the tutorial click Start > Programs/All Pro
rotector Suite QL > Fingerprint Tutorial after installing the driver.

ingerprint Reader Driver Installation
. Insert the Device Drivers & Utilities + User’s Manual disc into the

DVD drive.
. Click Option Drivers (button).
. Click 4.Install FingerPrint Driver > Yes.
. Click Software Installation.
. Click Next > Next > Next.
. Click Finish > Yes to restart the computer.
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7

tector Suite > Control Center, or 
ize).
ked to click the Accept button to 

u will be prompted to do so (note: If 
e cannot secure access to your 

ord.
erprints (you can click Tutorial to get 
Modules & Options

- 52 Fingerprint Reader Module

User Enrollment
1. Click Start > Programs/All Programs > Pro

double click the taskbar icon  (click Initial
2. On the first run of the program you will be as

accept the license.
3. If you have not set a Windows password yo

you have not set a password Protector Suit
computer).

4. Click Submit when you have entered passw
5. You will then be prompted to enroll your fing

help with fingerprint enrollment at any time).

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 48
Fingerprint 
Enrollment

Tutorial
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7

6 for that 

7
8  then 

9
1

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 49
Fingerprint Status
Finge

. Click the button above any of the fingers to begin the enrollment process 
finger.

. Swipe the finger until the progress bar reaches 100% to enroll that finger.

. Repeat the process for all the fingers you wish to enroll (see sidebar), and
click Save and Continue.

. Enter a backup password and click Apply.
0. Close the fingerprint status window.
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art Control Center (and then swipe a 
ister Applications, edit Settings and 
 the Control Center etc. from the 
rograms menu
 more information on any topic.
ur video to get more information.

rther details.
y time you can access the Biomenu 

ccess the Personal Safe, E-Wallet or 
trol Center and access the Help 
Modules & Options
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11. Right-click the taskbar icon  and select St
finger) to allow you to Edit Fingerprints, reg
access the Help menu etc. You can also run
Protector Suite item in the Programs/All P

12. Click “Help” in Control Center Home to get
13. You can also run the Tutorial, or Product To

14. See “Help & Manual” on page 7 - 51 for fu
15. If you swipe your finger over the reader at an

to lock the computer, register websites, a
Strong Password Generator, open the Con
menu.

Help

Figure 7 - 50
Control Center & 

Biomenu 
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F

A
T ed when
as f the reg-
is tered the
ap ensor.

P
T ther set-
ti

S
S resistant
to

E
T ion such
as

F
F  to store
fi

Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
Finge

ingerprint Control Center Features

pplication Launcher
he Application Launcher allows you to register applications to be launch
signed to a particular finger. Simply copy the application icon on to one o
tered fingers and ten click OK to close the application window. Once regis
plication will launch when you swipe the appropriate finger across the s

assword Bank
he Password Bank stores registrations of user names, passwords and o
ngs for web sites etc. 

trong Password Generator
trong Password Generator helps you to create complicated passwords 
 dictionary attacks from the Internet.

-Wallet
he E-Wallet provides biometric security for important personal informat
 credit card details, account numbers etc.

ile Safe
ile Safe is an encrypted area assigned on your hard drive that allows you
les and folders to be protected by fingerprint protection.
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Troubleshooting

Overview 8 - 1

8

C
O
S service representative, you may want
to ms and their possible solutions. This
ca . If you don’t find the answer in these
p  the safety precautions in the preface.
If a record of what happened and what
re

O time possible, so you should preview
th ill won’t cooperate, try turning it off
fo it may start working again. Then call
y

hapter 8: Troubleshooting
verview

hould you have any problems with your computer, before consulting your 
 try to solve the problem yourself. This chapter lists some common proble
n’t anticipate every problem, but you should check here before you panic

ages, make sure you have followed the instructions carefully and observed
 all else fails, talk to your service representative. You should also make 
medies you tried.

f course, if something goes wrong, it will happen at the most inconvenient 
is section just in case. If, after you’ve tried everything, and the system st
r a few minutes and then rebooting. You will lose any unsaved data, but 

our service representative.
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8

B
M  a problem when your computer ap-
p

• et? If plugged into a power strip, 
ation Indicators (see “LED Indica-

•  connections anywhere.

• p mode by pressing the keys config-
, the Fn + F4 key combination, or 

• 8 and F9 keys to adjust the bright-

• xternal only” display.

• e devices in any connected drive 
the disk, and then press any key” / 
Troubleshooting

- 2 Basic Hints and Tips

asic Hints and Tips
any of the following may seem obvious but they are often the solution to

ears not to be working. 

Power - Is the computer actually plugged into a working electrical outl
make sure it is actually working. Check the LED Power & Communic
tors” on page 1 - 9) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose

Power Savings - Make sure that the system is not in Hibernate or Slee
ured in your Power Options (see “Power-Saving States” on page 3 - 6)
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “e

Boot Drive - Make sure there are no optical media and/or USB storag
(this is a common cause of the message “Invalid system disk - Replace 
“Remove disks or other media. Press any key to restart”).
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8

B
• rograms safe, but close to hand. 

heir original cases, e.g. in a CD wal-

•  can. You may schedule these pro-
se those that are provided free with 

• uter). This is especially important if 
enu” on page 5 - 10).

•  settings etc.(even if just brief notes).

 CPU in any way, may violate your war-
Backup an

ackup and General Maintenance
Always backup your important data, and keep copies of your OS and p
Don’t forget to note the serial numbers if you are storing them out of t
let.

Run maintenance programs on your hard disk and OS as often as you
grams to run at times when you are not using your computer. You can u
your OS, or buy the more powerful dedicated programs to do so.

Write down your passwords and keep them safe (away from your comp
you choose to use a Supervisor password for the BIOS (see “Security M

Keep copies of vital settings files such as network, dialup settings, mail

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the
ranty.
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V
• ch tells your program which viruses 

some of them may seriously harm 
mercially available and the defini-

•  are often triggered from within e-
 configure most Anti-Virus pro-
f files from people you know as the 
rded without the person’s knowl-

• D/DVD/USB device provides basic 
y refer to your OS’s documentation 
ill also provide such a disk (or at 
Troubleshooting

- 4 Viruses

iruses
Install an Anti-Virus program and keep the definitions file (the file whi
to look for) up to date. New computer viruses are discovered daily, and 
your computer and cause you to lose data. Anti-Virus programs are com
tions file updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’t know. Viruses
mail attachments so take care when opening any attached file. You can
grams to check all e-mail attachments. Note: You should also beware o
virus may have infected an address book and been automatically forwa
edge.

Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this C
information which allows you to startup your computer) handy. You ma
for instructions on how to make one, and many Anti-Virus programs w
least instructions on how to make one).
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ew Hardware/Software 8 - 5

8

U tware
• you are very sure of what you are 

• ou are not comfortable with what 

• at you are looking at the computer’s 
ased? Many problems are caused by 
cumentation of any new hardware 
E” or “READ ME FIRST”.

• n, and in many cases you will need 
nnected.

• e installed (latest driver files are 
Upgrading and Adding N

pgrading and Adding New Hardware/Sof
Do not be tempted to make changes to your Windows Registry unless 
doing, otherwise you will risk severely damaging your system.

Don’t open your computer or undertake any repair or upgrade work if y
you are doing.

Read the documentation. We can assume, since you are reading this th
manual, but what about any new peripheral devices you have just purch
the installation of new hardware and/or software. Always refer to the do
and/or software, and pay particular attention to files entitled “READ M

When installing a new device always make sure the device is powered o
to restart the computer. Always check that all the cables are correctly co

Make sure you have installed the drivers for any new hardware you hav
usually available to download from vendor’s websites).
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• e changes may affect one or more 
o the change you just made and see 

• asier the source of the problem may 
ts ports, and a number of programs 
 disconnecting all of the devices and 
cess of elimination (adding and 
rce of a problem, although this may 
Troubleshooting

- 6 Upgrading and Adding New Hardware/Software

Thoroughly check any recent changes you made to your system as thes
system components, or software programs. If possible, go back and und
if the problem still occurs.

Don’t over complicate things. The less you have to deal with then the e
be found; Example - if your computer has many devices plugged into i
running, then it will be difficult to determine the cause of a problem. Try
restarting the computer with all the peripheral devices unplugged. A pro
removing devices and restarting where necessary) will often find the sou
be time consuming.
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and Possible Solutions 8 - 7

8

P

se - Solution

 Check the battery bay, make sure the
the design of the battery only allows it to
ing interfering with the battery contacts.

ource. If the computer doesn’t start up

f your OS has a Power Options scheme
eck its settings. You may also be using

evice that is drawing a lot of power.

ged before being recharged. Make sure
harge it completely before reusing (see
3 - 10).

o to the Control Panel in Windows and

sCard is consuming a lot of power. Turn
ower.
Problems 

roblems and Possible Solutions

Problem Possible Cau

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed.
battery is present and seated properly (
go in one way). Make sure there’s noth

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the DC power s
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. I
(see “Power Plans” on page 3 - 4) ch
an ExpressCard/USB device/external d

Actual battery operating time is shorter
than expected.

The battery has not been fully dischar
the battery is fully discharged and rec
“Energy Star Power Saving” on page
Power Options have been disabled. G
re-enable the options.

A peripheral device/USB device/Expres
off/remove the unused device to save p
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8

tilated and the Vent/Fan intakes are not
 the system into Hibernate mode or turn
ter isn’t sitting on a thermal surface (see
sure you’re using the correct adapter. 

letely powered off before putting it into a
ing a notebook which is powered on in a
kes to be blocked.

mode. Toggle the sleep/resume key
g the Power Buttons” on page 3 - 8/).

justed. Toggle the screen control key
ected to an external monitor, make sure
should also check the monitor’s own

display. Toggle the screen display key
nitor is connected, turn it on.

ny key or touch the TouchPad.

and configured it appropriately from the
nstructions on installing and configuring

se - Solution
Troubleshooting

- 8 Problems and Possible Solutions

The computer feels too hot. Make sure the computer is properly ven
blocked. If this doesn’t cool it down, put
it off for an hour. Make sure the compu
“Overheating” on page 1 - 16). Make 

Make sure that your notebook is comp
travel bag (or any such container). Putt
travel bag may cause the Vent/Fan inta

Nothing appears on screen. The system is in a power saving 
combination, Fn + F4 (see “Configurin

The screen controls need to be ad
combinations Fn + F8/F9. If you’re conn
it’s plugged in and turned on. You 
brightness and contrast controls.

The computer is set for a different 
combination, Fn + F7. If an external mo

The screen saver is activated. Press a

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver 
Control Panel. See Appendix B for i
the video driver.

Problem Possible Cau
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and Possible Solutions 8 - 9

8

ve to discharge the battery of the CMOS.
help.

eck the volume control in the Volume
 or use the key combination Fn + F5 and
” on page 1 - 13) to adjust.

/DVD cleaner kit.

 the tray. Gently try to remove the disc
cs” on page 2 - 3).

ximum 5 times. See “DVD Regional

 turned ON. (see “LED Indicators” on

se - Solution

es of this could be serious. If you cannot
f the information on your hard disk.
Problems 

You forget the boot password. If you forget the password, you may ha
Contact your service representative for 

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Ch
Control Panel in the Windows taskbar,
F6 (see “Function/Hot Key Indicators

The CD/DVD cannot be read. The CD/DVD is dirty. Clean it with a CD

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in
using the eject hole (see “Loading Dis

The DVD regional codes can no longer
be changed.

The code has been changed the ma
Codes” on page 2 - 5.

Unwelcome numbers appear when
typing.

If the LED  is lit, then Num Lock is
page 1 - 9).

Problem Possible Cau

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequenc
remember your boot password you must contact your vendor and you may lose all o
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ave timed-out. Use the AC/DC adapter,
ion, or press the power button if no LEDs

ed. Go to the Windows Power Options
refer (see “Power-Saving States” on
bled Hibernate mode from the control

dicator  and/or function key indicator
HSPA module is on or off (see “LED
 indicator is off, then press the Fn + F11
  (3.75G) key combination(s) in order

Hot Key Indicators” on page 1 - 13).

se - Solution

tandard USB keyboard. The system will
he system’s regular keyboard may not
Troubleshooting

- 10 Problems and Possible Solutions

The system freezes or the screen goes
dark.

The system’s power saving features h
press the sleep (Fn + F4) key combinat
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabl
menu and enable the features you p
page 3 - 6). Make sure you have ena
panel.

The Wireless LAN/Bluetooth/3.5G
modules cannot be detected.

The modules are off. Check the LED in
to see if the WLAN/Bluetooth/3.75G/
Indicators” on page 1 - 9). If the LED
(WLAN), Fn + F12 (Bluetooth) or Fn +
to enable the modules (see “Function/

Problem Possible Cau

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any s
detect and enable it automatically. However special functions/hot keys unique to t
work.
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8

 key combination in order to enable the
dicators” on page 1 - 13). Run the
 picture.

ot been installed. Make sure you have
e module (see the instructions for the
tions” on page 7 - 1).

uter and a Bluetooth enabled device is
(simultaneous data transfer is not
m your computer to a Bluetooth enabled
ile from the Bluetooth enabled device to
process from the computer has been

ill be off after resuming from the Sleep
bination (Fn + F12) to power on the

sumes from Sleep.

se - Solution
Problems a

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10
module (see “Function/Hot Key In
BisonCap program to view the camera

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have n
installed the driver for the appropriat
appropriate module in “Modules & Op

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the comp
supported in one direction only 
supported). If you are copying a file fro
device, you will not be able to copy a f
your computer until the file transfer 
completed

The Bluetooth module is off after
resuming from Sleep.

The Bluetooth module’s default state w
power-saving state. Use the key com
Bluetooth module after the computer re

Problem Possible Cau
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S
If ring after resuming from Sleep in
W  This error arises in compliance with
W nager) when the notebook lid (S3) is
cl e LCD display back when the lid is
o  result in screen flickering or a screen
re e OS:

1 istrative Tools icon (System and 

2

tenance
Troubleshooting

- 12 Screen Resolution Error

creen Resolution Error
 you are experiencing either screen resolution reduction, or screen flicke
indows Vista only then follow the instructions below to fix this problem.
indows Vista policy, which triggers TMM (Transient Multi-Monitor Ma
osed. TMM disconnects the LCD display from the OS and then adds th
pened. This may trigger TMM to restore an old display setting which may
solution change. To fix this problem you will need to disable TMM in th

. Go to the Control Panel in the Windows OS and double-click the Admin
Maintenance).

. Double-click Task Scheduler (Schedule Tasks).

Figure 8 - 1 - Control Panel System and Main
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8

3
4
5

6

Sc

. Double-click Task Scheduler Library > Microsoft > Windows.

. Click MobilePC to open the control panel.

. Right-click TMM and select Disable.

Figure 8 - 2 - TMM Disable

. Close all the control panels.
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Interface (Ports & Jacks)

terface (Ports & Jacks) A - 1

A

A cks)
O
T & jacks) which allow your computer
to

ital storage cards. Push the card into the

your computer.

 Flat Panel Display, to get dual video or
PD.

external Serial Advanced Technology

is an audio/video connector interface for
ou to connect an external monitor, TV or
 a HDMI cable. Note that HDMI carries
e B - 6) and video signals.
In

ppendix A: Interface (Ports & Ja
verview

he following chapter will give a quick description of the interface (ports 
 communicate with external devices, connect to the internet etc.

Item Description

Card Reader Port The card reader allows you to use some of the latest dig
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power 

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or
simultaneous display on the LCD and external monitor/F

e-SATA Port Plug external Serial ATA hard drives into this e-SATA (
Attachment) port. 

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) 
transmitting uncompressed digital streams. This allows y
Flat Panel Display etc. as a display device by means of
both audio (see “HDMI Audio Configuration” on pag

e-SATA /



A

A

 jack. Note: Set your system’s volume to

your computer.

to the LAN port.

be attached to this slot. Locks can be

t Jack allows you to connect your DVD-
” or ‘dts’ surround sound.

USB 1.1 compliant) are for low-speed
nd for high-speed peripherals such as
nners etc. Devices can be plugged into

ut the need to turn the system off (if the
ke sure you use the power supply which
Interface (Ports & Jacks)

- 2 Interface (Ports & Jacks)

Headphone-Out Jack Headphones or speakers may be connected through this
a reduced level before connecting to this jack.

Microphone-In Jack Plug an external microphone in to this jack to record on 

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect 

Security Lock Slot To prevent possible theft, a Kensington-type lock can 
purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Ou
capable PC to a Dolby AC-3 compatible receiver for “5.1

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully 
peripherals such as keyboards, mice or scanners, a
external HDDs, digital video cameras or high-speed sca
the computer, and unplugged from the computer, witho
power rating of your USB device is 500mA or above, ma
comes with the device).

Item Description
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B

A ntrols
T res” on
p

A
M ge 4 - 3.
In l Drivers
(b

1
2
3 the 

4
5

N  panel to
ad n page 1
- 

Video Card 
Options

Note that card types,
specifications and driv-
ers are subject to con-
tinual updates and
changes. Check with
your service center for
the latest details on
video cards supported.
ATI V

ppendix B: ATI Video Driver Co
he basic settings for configuring the LCD are outlined in “Video Featu
age 1 - 17.

TI Video Driver Installation
ake sure you install the drivers in the order indicated in Table 4 - 1, on pa
sert the Device Drivers & Utilities + User’s Manual disc and click Instal
utton).

. Click 2.Install Video Driver > Yes.

. Click Next > Install (button).

. Click the Express (or Custom if you prefer to manually configure 
driver installation settings) button and click Next.

. Click Accept (button) and click Yes.

. Click Finish > Yes to restart the computer.

ote: After installing the video driver go to the Display Settings control
just the video settings to the highest resolution (see “Video Features” o

19).
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B

ter
st® Control Center.

) control panel.

nd then click ATI Catalyst Control

lick Next.
p you set up the display options, or if
 taken to the ATI Catalyst Control
 Basic menu or the View menu in the

Note that the control panels
pictured in the following pages
are from the Advanced set-
tings. 
ATI Video Driver Controls

- 2 ATI Catalyst® Control Center

ATI Catalyst® Control Cen
Adjust the video settings from the ATI Cataly

1. Open the Display Settings (see page 1 - 17
2. Click Advanced Settings (button).
3. Click Catalyst(R) Control Center (tab) a

Center (button) to start the control center.
4. Select either Basic or Advanced and then c
5. If you have selected Basic a wizard will hel

you have selected Advanced you will be
Center (you can change the options from the
ATI Catalyst Control Center).

ATI Taskbar Icon

The ATI Catalyst Control
Center can be accessed as
above or by double-clicking
the icon  in the taskbar
(or by right-clicking the icon
and selecting Catalyst
Control Center).

If you don’t see the ATI icon
in the taskbar, click Prefer-
ences (tab) in the ATI Cat-
alyst® Control Center,
and select Enable System
Tray Menu.

Right-click the ATI icon 
to bring up the taskbar
menu.

Figure B - 1
ATI Catalyst Control 

Center Basic Settings
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talyst® Control Center B - 3

B

T tion con-
tr , 3D Set-
ti raphics
S Help Menus

Click Help (tab) and se-
lect an option from the
drop down menu. Press
F1 to bring up Help for
any currently selected
page.

Figure B - 2
ATI Catalyst Control 

Center Advanced 
Settings
ATI Ca

he ATI Catalyst® Control Center provides additional video configura
ols and tools which allow quick access to features such as display options
ngs, color and Help menus etc. Adjust settings from the options in the G
ettings Tree View pane.
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ws Vista
nitor port/HDMI-Out port and turn it on.
t appear in Windows Vista, go to the
obile PC > Adjust commonly used
y.

 displays to your preferences, or click
ected window) to access the control

ing Fn + F7
 you are using the Fn + F7 Hot Key combi-
atically switch back to/from the HDMI con-
I Audio Configuration” on page B -
ATI Video Driver Controls

- 4 Attaching Other Displays

Attaching Other Displays
Configuring an External Display in Windo
1. Attach your external display to the external mo
2. If a New Display Detected window does no

Windows Mobility Center control panel (M
mobility settings) and click Connect displa

3. Click on any of the buttons to configure the
Display Settings (in the New Display Det
panel.

Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The fol-
lowing are the display
options:

• The built-in LCD.
• An external monitor 

connected to the 
external monitor port.

• A flat panel display 
connected to the 
external monitor port.

Figure B - 3
New Display 

Detected

Switching Displays Us
If your external display is connected to the HDMI port, and
nation to switch displays; note that the audio will not autom
nection and will need to be manually switched. See “HDM
6 for details.
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taching Other Displays B - 5

B

C nter
A e any at-
ta

1 turn it on.
2. ge  B - 2).
3
4
5 ons (see

6
7

Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

Configure the Display
Detection Option from
Display Options in the
Graphics Settings
Tree View pane. You
can configure the Cata-
lyst® Control Center
to manually or automati-
cally detect attached
displays. 

Figure B - 4
 Displays Manager
At

onfiguring an External Display using the ATI Catalyst Control Ce
lternatively you can use the ATI Catalyst Control Center to configur
ched displays.

. Attach your external display to the external monitor port/HDMI-Out port and 
Go to ATI Catalyst Control Center (see “ATI Catalyst® Control Center” on pa

. Select Displays Manager from the Graphics Settings Tree View pane.

. Attached displays will appear in the Desktop and Display Setup box.

. Right-click, the attached display icon to bring up the Display Mode opti
“HDMI Audio Configuration” on page B - 6).

. Select an option from the menu, and click Yes to accept the settings.

. Click OK to save the changes.

Right-click the attached
display icon and select an
option (Clone or Extend)
from the menu. 
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 carries both audio and video signals
 per the instructions below when an
I-Out port.

DMI-Out port.
 to Settings and click Control Panel).

ital Output Device (HDMI).
I) (or right-click the icon and select

Click the taskbar volume in-
dicator  when HDMI De-
vice is selected, and you will
note that the icon at the top of
the volume level indicator
has changed.
ATI Video Driver Controls

- 6 Attaching Other Displays

HDMI Audio Configuration
HDMI (High-Definition Multimedia Interface)
and you will can configure the audio output as
HDMI enabled device is connected to the HDM

Windows Audio Setup for HDMI
1. Connect a device with HDMI support to the H
2. Click Start, and click Control Panel (or point
3. Click Sound  (Hardware and Sound).
4. Click Playback (tab), and click to select Dig
5. Double-click Digital Output Device (HDM

Properties).

Figure B - 5
HDMI Device
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taching Other Displays B - 7

B

6
7

Figure B - 6
HDMI Device 

Properties
At

. Adjust the HDMI settings from the control panel tabs.

. Click OK to close the Sound  control panel.
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 HDMI-Out port BEFORE attempt-
device.

port to your external display.
he instructions in “Configuring an
ontrol Center” on page B - 5.
r HDMI input (see your display device

gh your external display.
ATI Video Driver Controls

- 8 Attaching Other Displays

HDMI Notes
• Connect a device with HDMI support to the

ing to play audio/video sources through the 

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out 
2. Configure your external display as per t

External Display using the ATI Catalyst C
3. Set up your external display (TV or LCD) fo

manual).
4. You can now play video/audio sources throu

Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).



ATI Video Driver Controls

Display Modes B - 9

B

D
S
O

C
C the other
d tent, res-
o

E
E ey act as
a enabled,
y therefore
p  program
v

Function Keys

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Give the displays
enough time to refresh.

Swap Display 
Mapping

If you wish to switch the
Main and Clone dis-
plays, right-click either
the Main or Clone icon
(Displays Manager),
and then click Swap
Display Mapping.

F7 Hot
h back
 Audio
isplay Modes
ingle
nly one of your displays is used.

lone Mode
lone Mode simply shows an exact copy of the Main display desktop on 
isplay(s). This mode will drive multiple displays with exactly the same con
lution, refresh rates and color quality etc. 

xtended Mode
xtended Mode treats both connected displays as separate devices, and th
virtual desktop resulting in a large workspace. When Extended Mode is 
ou can drag any icons or windows across to the other display desktop. It is 
ossible to have one program visible in one of the displays, and a different
isible in the other display.

Switching Displays Using Fn + F7
If your external display is connected to the HDMI port, and you are using the Fn + 
Key combination to switch displays; note that the audio will not automatically switc
to/from the HDMI connection and will need to be manually switched. See “HDMI
Configuration” on page B - 6 for details.
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B

e Main display desktop on the other
lays with the same content. Use this
r for a presentation. 

 any attached display here to disable it,
imply drag it back to the Clone window
enable it.
ATI Video Driver Controls

- 10 Display Modes

Clone Mode
Clone Mode simply shows an exact copy of th
display(s). This mode will drive multiple disp
feature to display the screen through a projecto

Selecting Display 
Modes

Right-click the at-
tached display icon

 and select an
option (Clone or Ex-
tend) from the menu. 

Figure B - 7
Displays Manager 

Clone Mode

Drag
and s
to re-

Click Monitor Properties to make adjust-
ments for any attached displays.
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Display Modes B - 11

B

E
In indows
d iguration
is  config-
u

Selecting Display 
Modes

Right-click the at-
tached display icon

 and select an
option (Clone or Ex-
tend) from the menu.
 

Extended Mode

When enabled, you
can drag any icons or
windows across to the
other display desktop.
It is therefore possible
to have one program
visible in one of the
displays, and a differ-
ent program visible in
the other display.

Figure B - 8
 Displays Manager

Extended Mode

hics
, or
opri-

from
ay....
xtended Mode
 Extended Mode each monitor can be configured separately with the W

esktop stretched between the two monitors (except the taskbar). This conf
 recommended if you are using two monitors of different size, as you may
re the best resolution, refresh rates and color quality for each display.

Click either the Grap
Adapter pop-up menu
click the icon for the appr
ate display. 

Configure the settings 
the Selected Displ
menu.
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tended Mode
nitor port/HDMI-Out port and turn it on.
t appear in Windows Vista, go to the
obile PC > Adjust commonly used
y.
esktop on each display (extended).
top.
ATI Video Driver Controls

- 12 Display Modes

Using New Display Detected to Enable Ex
1. Attach your external display to the external mo
2. If a New Display Detected window does no

Windows Mobility Center control panel (M
mobility settings) and click Connect displa

3. Click to select Show different parts of my d
4. Click Right or Left under Extend your desk
5. Click Apply > OK.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 9
New Display 

Detected
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Display Modes B - 13

B

U
1 turn it on.
2 panel.
3 tend the  Display Settings 

Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 10
Display Settings 

(Extend the 
Desktop)

or icon
the op-
n to it.

ry Dis-
ondary
sing Display Settings to Enable Extended Mode
. Attach your external display to the external monitor port/HDMI-Out port and 
. Open Display Settings (see “Video Features” on page 1 - 17) control 
. Click the monitor icon (e.g. ), and make sure you have checked “Ex

desktop onto this monitor” and click Apply.
2

Click the appropriate monit
(e.g. ) to be able to select 
tion to extend the desktop o

In this example the Prima
play  is on the left, the Sec
Display  is on the right.

2

1
2
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yback in full screen on a secondary
 the Avivo™ Video > Theater Mode
ATI Video Driver Controls

- 14 Theater Mode

Theater Mode
Theater Mode enables you to display video pla
monitor. Theater Mode can be configured from
tab in the Graphics Settings Tree View pane.

Figure B - 11
Theater Mode
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PowerPlay™ B - 15

B

P
P set your
g

Figure B - 12
PowerPlay™
owerPlay™
owerPlay™ in the Graphics Settings Tree View pane allows you to 
raphics processor settings for higher performance or longer battery life.
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B
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Specifications

Specifications C - 1

C

A

rtain items (particularly processor types/
anufacturer's release schedule. Check
ppendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Ce
speeds and CD/DVD device types) may be changed, updated or delayed due to the m
with your service center for details.
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Audio

High Definition Audio Compliant Interface
3D Stereo Enhanced Sound System
S/PDIF Digital Output
Built-In Microphone
2 * Built-In Speakers 1W, 8Ω

Keyboard & Pointing Device

Full Size WinKey Keyboard 
Built-in TouchPad (integrated scrolling 
key functionality) with Multi Gesture 
Function
Three Instant Keys (WWW, E-Mail, Silent 
Mode)

Card Reader

Embedded 7-in-1 Card Reader (MS/ MS 
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS 
Duo) Note: MS Duo/ Mini SD/ RS MMC 
Cards require a PC adapter
Specifications

- 2 Specifications

Processor

Intel® Core i7-820QM Processor:
1.73GHz
45nm (45 Nanometer) Process 
Technology, 8M L3 Cache & 
FSB 1333MHz - TDP 45W
rPGA988 Package

Intel® Core i7-720QM Processor:
1.6GHz
45nm (45 Nanometer) Process 
Technology, 6M L3 Cache & 
FSB 1333MHz - TDP 45W
rPGA988 Package

Core Logic

Intel® PM55 Chipset

Display

Model A Computers:
17” WXGA(1440 * 900) / WUXGA (1920 * 
1200) TFT LCD

Model B Computers:
15.6” HD 16:9 Wide Screen (1366 * 768) 
/ HD+(1600 * 900) / FHD (1920 * 1080) 
TFT LCD

Memory

Dual Channel DDRIII (DDR3) 
Two 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1066/1333MHz
Memory Expandable up to 4GB 
(1GB / 2GB DDRIII (DDR3) Modules)

Video Adapter

ATI Mobility Radeon HD 4570 Discrete 
Graphics On Board (PCIe 2.0 * 8)

512MB GDDR2 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP

BIOS

One 32Mb SPI Flash ROM
Phoenix™ BIOS

Storage

One Changeable 12.7mm(h) Optical 
Device (CD/DVD) Type Drive (see 
“Optional” on page C - 4) 

Easy Changeable 2.5" 9.5 mm (h) SATA 
(Serial) HDD
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Specifications C - 3

C

Communication (cont’d)

Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)
2.0M Pixel USB PC Camera Module 
(Factory Option)
UMTS/HSPDA-based 3.75G Module with 
USB Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 
MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)
Note that UMTS modes CAN NOT be 
used in North America.

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Resume From Modem Ring
Interface

Three USB 2.0 Ports
One eSATA Port (Supported in Windows 
Vista/Windows 7 Only)
One HDMI Out Port
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF-Out Jack
One RJ-11 Jack
One RJ-45 LAN Jack
One DC-In Jack

Slots

One ExpressCard/34/54 Slot
Two Mini-Card Slots (USB/PCIe):
Slot 1 for WLAN Module with HMC Slot 
and PCIe Interface
Slot 2 for 3.75G Mini-Card Slot with USB 
Interface (Factory Option)

Communication

Built-In 56K MDC Modem V.90 & V.92 
Compliant
Built-In Gigabit Ethernet LAN
Intel® WiFi Link Module 5300 3*3 802.11 
a/g/n HMC with PCIe Interface (Factory 
Option)
Intel® Advanced N WiFi Link 6200 Wireless 
LAN Module 802.11 a/g/n 612AN Half Mini-
Card with PCIe Interface (Factory Option)
Intel® Ultimate N WiFi Link 6300 Wireless 
LAN Module 802.11 a/g/n 633AN Half Mini-
Card with PCIe Interface (Factory Option)
3rd Party 802.11b/g HMC Wireless Lan 
Module with PCIe Interface (Factory 
Option)
3rd Party 802.11b/g/n HMC Wireless Lan 
Module with PCIe Interface (Factory 
Option)



C

C

Optional

Optical Drive Module Options:
Super Multi Drive Module
Blu-Ray Combo and Blu-Ray Writer 
Module
Intel® WiFi Link 5300 WLAN Module 
(Factory Option)
Intel® Advanced N WiFi Link 6200 HMC 
WLAN Module (Factory Option)
Intel® Ultimate N WiFi Link 6300 HMC 
WLAN Module (Factory Option)
802.11b/g HMC WLAN Module (Factory 
Option)
802.11b/g/n HMC WLAN Module (Factory 
Option)
Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)
2.0M Pixel USB PC Camera Module 
(Factory Option)
9 Cell Smart Lithium-Ion Battery Pack, 
7200mAH
Fingerprint Reader Module (Factory 
Option)
UMTS/HSPDA-based 3.75G Module with 
USB Mini-Card Interface (Factory Option)
Specifications

- 4 Specifications

Power

Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 19V, 4.74A (90 Watts)
6 Cell Smart Lithium-Ion Battery Pack, 
4400mAH
9 Cell Smart Lithium-Ion Battery Pack, 
7200mAH (Option)

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module (Factory 
Option)

Operating System

Windows® Vista (with Service Pack 2)
Windows® 7

Environmental Spec

Temperature 
Operating:   5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

Model A Computers:
397.2mm (w) * 282.5mm (d) * 39.5mm (h)
2.9 kg With 6 Cell Battery & ODD

Model B Computers:
374mm (w) * 256mm (d) * 37.9mm (h)
2.6 kg With 6 Cell Battery & ODD



Windows 7 Information

D - 1

D

A ion
T , driver installation etc.) for users of
th  Vista, or where is it helpful to have
es d here see the remainder of the man-
u

ppendix D: Windows 7 Informat
his Appendix contains information (including control panel information
e Windows 7 OS where there are significant differences from Windows
sential information or features repeated. For items not specifically covere

al for information.
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M
T  indicated in the table below however
al

Model B

D 16:9 Wide Screen (1366 * 768) / 
HD+ (1600 * 900) / 

HD (1920 * 1080) TFT LCD
Windows 7 Information

- 2 Model Differences

odel Differences
his notebook series includes two different model types. The models differ as
l other features, modules and specifications are identical (see Appendix D).

Table D - 1 - Model Differences

Feature Model A

Display Type 
Supported

17" WXGA(1440 * 900) / 
WUXGA (1920 * 1200) TFT LCD

15.6" H

F

Design
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DVD Regional Codes D - 3

D

D

m), then click the + next to DVD/CD-ROM
elect the DVD Region (tab) to bring up the

 region code 5 times. The fifth selection is
odule in another computer.
VD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table D - 1 - DVD Region Codes

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (System and Security > Syste
drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and s
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s
permanent. This cannot be altered even if you change your operating system or you use the m
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D

W
M ost other Windows versions) are ac-
ce  will be installed on your hard disk
d esktop. Right-click the Start menu
ic ce of the Start menu.

In en the Control Panel. The Control
P  settings for most of the key features
in sic controls for many of the features,
h en you install the drivers. To see all
co ol panel icons.

 & Control Panel

lick here to toggle Category View
Windows 7 Information

- 4 Windows 7 Start Menu & Control Panel

indows 7 Start Menu & Control Panel
ost of the control panels, utilities and programs within Windows 7 (and m
ssed from the Start menu. When you install programs and utilities they

rive, and a shortcut will usually be placed in the Start menu and/or the d
on , and then select Properties if you want to customize the appearan

 many instances throughout this manual you will see an instruction to op
anel is accessed from the Start menu, and it allows you to configure the
 Windows (e.g. power, video, network, audio etc.). Windows 7 provides ba

owever many new controls are added (or existing ones are enhanced) wh
ntrols it may be necessary to toggle off Category View to view the contr

Figure D - 1 - Start Menu

C
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D

F
T the Fn key is held down. In addition
to n the hot key utility is installed.

ors

Function

rease

See “Switching Displays 
Using Fn + F7” on page B - 4

ncrease

er 

 Toggle

r Toggle

 fan noise and save power consumption. Note this 
omputer performance.
Windows 7 Start

unction/Hot Key Indicators
he function keys (F1 - F12 etc.) will act as hot keys when pressed while 
 the basic function key combinations; visual indicators are available whe

Table D - 2 - Function & Hot Key Indicat

Fn Keys Function Fn Keys

Fn + ~ Play/Pause 
(in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Inc

Fn + _ 
3.75G Module 
Power Toggle* Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/F9 Brightness Decrease/I

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F10 PC Camera Pow

Toggle

Fn + F3 Mute Toggle Fn + F11 WLAN Module Power

Fn + F4  Sleep Toggle Fn + F12 Bluetooth Module Powe

*Silent Mode Toggle  *When enabled, Silent Mode will reduce
may reduce c
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D

H
T il program, and allow you to toggle
th  the E-Mail button will only function
af cations are not installed by default in
W

ser

gram

ving)
Windows 7 Information

- 6 Windows 7 Start Menu & Control Panel

ot Key Buttons & Keyboard
hese buttons give instant access to the default Internet browser and e-ma
e Silent Mode on/off with one quick button press. Note that in Windows 7
ter the Outlook or Outlook Express applications are installed (these appli
indows 7). 

Hot Key Function

Activate the Default E-Mail Brow

 Activate the Default Internet Pro

Toggle *Silent Mode (for power sa
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Video Features D - 7

D

V
Y ws, and from the ATI Catalyst Con-
tr etailed video
in

T
1
2 .
3
O
4  (see right).
5 ge D - 8).
6  Advanced properties tabs.

T
1   Figure D - 2 on page D - 8).
2
3
O
4 te that you may need click the show

).
O
5

3

ideo Features
ou can configure display options from the Display control panel in Windo
ol Center as long as the appropriate video driver is installed. For more d
formation see “ATI Catalyst® Control Center” on page B - 2.

o access Display (Control Panel) and Screen Resolution in Windows:
. Click Start and click Control Panel.
. Click Display (icon) - In the Appearances and Personalization category
. Click Adjust Screen Resolution/Adjust resolution.
R

. Alternatively you can right-click the desktop and select Screen resolution

. Use the dropbox to select the screen Resolution  (Figure D - 2 on pa

. Click Advanced settings  (Figure D - 2 on page D - 8) to bring up the

o access the ATI Catalyst Control Center:
. Click Start and click All Programs (or just click Start and select ATI CCC
. Click Catalyst Control Center.
. Click ATI CCC (Advanced/Wizard)  (Figure D - 2 on page D - 8).
R

. Double-click the taskbar icon   (Figure D - 2 on page D - 8 - no
hidden icons button in the taskbar in order to see the ATI taskbar icon 

R
. Right-click the desktop and select Catalyst(TM) Control Center.

1
2

4

5
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S
B RT)/external Flat Panel Display as
y

ntrols

3
4

5

Windows 7 Information
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creen Resolution
esides the built-in LCD, you can also use an external VGA monitor (C
our display device.

Figure D - 2 - Screen Resolution & ATI Co

1

2
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D

A
C
1  turn it on.
2
3
4

isplays

Video Options

at card types, specifications
ers are subject to continual
 and changes. Check with
rvice center for the latest de-
video cards supported.
ttaching Other Displays
onfiguring an External Display in Windows 7
. Attach your external display to the external monitor port/HDMI-Out port and
. Go to the Screen resolution control panel.
. Click the Detect button.
. The computer will then detect any attached displays.

Figure D - 3 - Screen Resolution - Multiple D

Note th
and driv
updates
your se
tails on 
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D

5

lay Options
• ktop on the other display(s)
• ices
•

S en using the ATI driver to configure
at
Windows 7 Information

- 10 Video Features

. You can configure the displays from the Multiple Displays menu.

Figure D - 4 - Screen Resolution - Multiple Disp
Duplicate these displays - Shows an exact copy of the main display des
Extend these displays - Treats both connected displays as separate dev
Show desktop only on 1/2 - Only one of your displays is used.

ee “Display Modes” on page B - 9 for more details on the above modes wh
tached displays.
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D

A
A

1 D - 7).
2 then click

3 ions, or if
ol Center
n the ATI

Figure D - 5
ATI Catalyst Control 

Center Basic Settings

l panels
g pages

ced set-
TI Catalyst® Control Center
djust the video settings from the ATI Catalyst® Control Center.

. Open the ATI Catalyst Control Center (see “Video Features” on page

. Select either Basic or Advanced (on the first run of the program) and 
Next.

. If you have selected Basic a wizard will help you set up the display opt
you have selected Advanced you will be taken to the ATI Catalyst Contr
(you can change the options from the Basic menu or the View menu i
Catalyst Control Center).

Note that the contro
pictured in the followin
are from the Advan
tings. 
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D

 additional video configuration con-
ures such as display options, 3D Set-
gs from the Graphics and Options
Windows 7 Information

- 12 Video Features

The ATI Catalyst® Control Center provides
trols and tools which allow quick access to feat
tings, color and Help menus etc. Adjust settin
menus at the top of the control panel.Help Menus

Click Help (tab) and se-
lect an option from the
drop down menu. Press
F1 to bring up Help for
any currently selected
page.

Figure D - 6
ATI Catalyst Control 

Center Advanced 
Settings
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D

C nter
A e any at-
ta

1  turn it on.
2.
3 e screen.
4  Displays

5
6
7

Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

Figure D - 7
 Desktops & 

Displays
onfiguring an External Display using the ATI Catalyst Control Ce
lternatively you can use the ATI Catalyst Control Center to configur
ched displays.

. Attach your external display to the external monitor port/HDMI-Out port and
Go to ATI Catalyst Control Center (see “Video Features” on page D - 7).

. Select Desktops & Displays from the Graphics menu in the top left of th

. Attached displays will appear in the lower part of the screen (click Detect
to find any attached displays that do not automatically appear).

. Right-click the attached display icon to bring up the options.

. Select an option from the menu, and click Yes to accept the settings.

. Click OK to save the changes.

Attached displays will ap-
pear here. 



D

D

itch Displays
to quickly change display configura-

nitor port/HDMI-Out port and turn it on.

he appropriate configuration from the
n (.
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Using the Fn + F7 Key Combination to Sw
You can also use the Fn + F7 key combination 
tion and modes.

1. Attach your external display to the external mo
2. Press the Fn + F7 key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or Fn + F7) to select t

menu, and press Enter to confirm the selectio

Figure D - 8
 Fn + F7 Display 
Configuration 

Selection
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D

D
S
O

D
D ther display(s). This mode will drive
m d color quality etc. 

E
E  a virtual desktop resulting in a large
w s across to the other display desktop.
It nd a different program visible in the
o

isplay Modes
ingle
nly one of your displays is used.

uplicate
uplicate simply shows an exact copy of the Main display desktop on the o
ultiple displays with exactly the same content, resolution, refresh rates an

xtend
xtend treats both connected displays as separate devices, and they act as
orkspace. When a display is Extended, you can drag any icons or window
 is therefore possible to have one program visible in one of the displays, a
ther display.



D

D

nitor port/HDMI-Out port and turn it on.
eo Features” on page D - 7).
ics menu in the top left of the screen.
t of the screen (click Detect Displays
atically appear).
nd select Disable.

ight-click the attached external display

Right-click and select Disable. 
Windows 7 Information
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Switching Display Modes
1. Attach your external display to the external mo
2. Go to ATI Catalyst Control Center (see “Vid
3. Select Desktops & Displays from the Graph
4. Attached displays will appear in the lower par

to find any attached displays that do not autom
5. Right-click the attached external display icon a
6. Click Yes to accept the settings.
7. After the external display has been disabled r

icon again.

Figure D - 9
Desktops & 

Displays (Disable)
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D

8
9
1 play and

Figure D - 10
Desktops & 

Displays 
(Extend Mode)
. Select Duplicate or Extend from the menu.

. Click Yes to accept the settings.
0. If you need to change the display mode then disable the external dis

configure as outlined here. 

Right-click and select either Duplicate or Extend. 
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D

DC adapter or a battery pack.

ur computer. The wrong type of AC/
omponents.

the left of the computer.
 connect the AC power cord to the AC/

e.

hile you are on the road or when an
s depending on the applications and

ttery life, let the battery discharge
 completely discharge the battery?”

ry. For more information on the bat-
page D - 27.
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The Power Sources
The computer can be powered by either an AC/

AC/DC Adapter
Use only the AC/DC adapter that comes with yo
DC adapter will damage the computer and its c

1.Attach the AC/DC adapter to the DC-in jack on 
2.Plug the AC power cord into an outlet, and then
DC adapter.
3.Raise the lid/LCD to a comfortable viewing angl
4.Press the power button to turn “On”.

Battery
The battery allows you to use your computer w
electrical outlet is unavailable. Battery life varie
the configuration you're using. To increase ba
completely before recharging (see “How do I
on page D - 31).

We recommend that you do not remove the batte
tery, please refer to “Battery Information” on 

Silent Mode

Use the  key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.



Windows 7 Information

ing On the Computer D - 19

D

T
N  the pow-
er

W ibernate/
S ssing and
h wn). Use
P

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page D
- 24 for details).

n com-
system
Turn

urning On the Computer
ow you are ready to begin using your computer. To turn it on simply press
 button on the front panel.

hen the computer is on, you can use the power button as a Stand by/H
hutdown hot-key button when it is pressed for less than 4 seconds (pre
olding the power button for longer than this will shut the computer do
ower Options in the Windows control panel to configure this feature.

Shut Down

Note that you should always shut your computer down by choosing the Shut Dow
mand from the Lock Button Menu in Windows 7. This will help prevent hard disk or 
problems.



D

D

P
wer by means of power plans. You

 create a new one.

to turn off after a specified time, and
f inactivity. 

nge advanced power settings to ac-
 Settings.
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ower Plans
The computer can be configured to conserve po
can use (or modify) an existing power plan, or

The settings may be adjusted to set the display 
to send the computer into Sleep after a period o

Click Change plan settings and then click Cha
cess further configuration options in Advanced

Resuming 
Operation

See Table D - 3, on
page D - 25 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure D - 11
Power Plan 

Advanced Settings
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D

E your ma-
ch eriencing
an

C s to view
th r is pow-
er  that this
sc r to save
p er) pow-
er

ATI PowerPlay™

PowerPlay™ in the ATI
Catalyst Control Cen-
ter (in the Graphics Set-
tings Tree View pane)
allows you to set your
graphics processor set-
tings for higher perfor-
mance or longer battery
life.

Figure D - 12
Power Plans
ach Windows power plan will also adjust the processor performance of 
ine in order to save power. This is worth bearing in mind if you are exp
y reduced performance (especially under DC/battery power).

hoose High performance (you may need to click Show additional plan
e High performance plan) for maximum performance when the compute
ed from an AC power source. Choose the Power saver (bear in mind
heme may slow down the overall performance of the computer in orde

ower) for maximum power saving when the computer is battery (DC pow
ed.

Click to Show/Hide 
additional 
power plans
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D

P
Y tart where you left off. Sleep is the
d

E -saving states. Windows 7 combines
th  state.

S
In ore the system sleeps. When you are
n n the operating system, it will enter
S

T  last left off (what was on your desk-
to

If e only a minimum amount of power.
A rd disk and shut the computer down
b

Windows 7 Information
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ower-Saving States
ou can use power-saving states to stop the computer’s operation and res
efault power-saving state in Windows 7.

arlier versions of Windows used Stand By and Hibernate as system power
e features of Stand By and Hibernate into the default Sleep power-saving

leep
 Sleep all of your work, settings and preferences are saved to memory bef

ot using your computer for a certain length of time, which you specify i
leep to save power. 

he PC wakes from Sleep within seconds and will return you to where you
p) without reopening the application(s) and file(s) you last used.

 your mobile PC in Sleep is running on battery power the system will us
fter an extended period the system will save all the information to the ha
efore the battery becomes depleted.
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D

H
H nd saves
al  off. If a
p f a power
fa  lost. Hi-
b u should
p period of
ti

S
Y don’t for-
g ), plan to
b p and run
a han from
S

Figure D - 13
Lock Button Menu
ibernate
ibernate uses the least amount of power of all the power-saving states a
l of your information on a part of the hard disk before it turns the system
ower failure occurs the system can restore your work from the hard disk; i
ilure occurs when work is saved only to memory, then the work will be
ernate will also return you to where you last left off within seconds. Yo
ut your mobile PC into Hibernate if you will not use the computer for a 
me, and will not have the chance to charge the battery.

hut down
ou should Shut down the computer if you plan to install new hardware (
et to remove the battery and follow all the safety instructions in Chapter 6
e away from the computer for several days, or you do not need it to wake u
scheduled task. Returning to full operation from Shut down takes longer t
leep or Hibernate.
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D

C
T to send the computer in to a power-
sa ower Options to bring up the menu.
Windows 7 Information
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onfiguring the Power Buttons
he power/sleep button (Fn + F4 key combo) and closed lid may be set 
ving state. Click Choose what the power buttons do on the left menu in P

Password Protection

It is recommended that you
enable a password on wake
up in order to protect your
data.

However you can disable
this setting from the Power
Options menu by clicking
Require a password on
wakeup in the left menu,
and selecting the options
(click Change settings that
are currently unavailable).

Figure D - 14
Power Options Define 

Power Buttons
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D

R
Y button, or in some cases pressing the
sl

 Combo)

uchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table D - 3
Resuming 
Operation

t Down
 power
Configuri

esuming Operation
ou can resume operation from power-saving states by pressing the power 
eep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/To

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shu
hot key button when it is pressed for less than 4 seconds (pressing and holding the
button for longer than this will force the computer to shut down).
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D

E
T omputers (CPU, hard drive, etc.) into
a t to enable Energy Star power saving
th

1
2
3 ide other power saving settings.

e D - 15
Star Menu
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nergy Star Power Saving
his system supports Energy Star power management features that place c
low-power sleep modes after a designated period of inactivity. If you wan
en follow these instructions:

. Right-click the taskbar icon.

. Select Power Conservation Modes.

. Select Energy Star to use the Energy Star power management and overr

Figur
Energy 



Windows 7 Information

Battery Information D - 27

D

B
F

B
Y  the pro-
g ons to be
ta els from
p e Figure
D

C d charge
st

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure D - 16
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
attery Information
ollow these simple guidelines to get the best use out of your battery.

attery Power
our computer’s battery power is dependent upon many factors, including
rams you are running, and peripheral devices attached. You can set acti
ken (e.g. Shut down, Hibernate etc.), and set critical and low battery lev
ower plan Change plan settings > Change advanced power settings (se
 - 11 on page D - 20).

lick the battery icon  in the taskbar to see the current battery level an
atus.
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 Power saver), however note that 
ance.

lay. The system will decrease LCD 
not powered by the AC/DC adapter.

y is turned off.

unication applications when they are 

al devices e.g. USB devices, 
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Conserving Battery Power
• Use a power plan that conserves power (e.g

this may have an affect on computer perform

• Lower the brightness level of the LCD disp
brightness slightly to save power when it is 

• Reduce the amount of time before the displa

• Close wireless, Bluetooth, modem or comm
not being used.

• Disconnect/remove any unnecessary extern
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure D - 17
Windows Mobility 

Center
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D

B
B ze the life and improve its perfor-
m  days.

W  to remove the battery for any reason
(e

N
A ry FAQ” on page D - 31 for instruc-
ti

R
T ed and plugged into an electrical out-
le fully recharge the battery. When the
co time is less. (Refer to “LED Indica-
to attery Information” on page D - 27
fo  pack.)
attery Life
attery life may be shortened through improper maintenance. To optimi
ance, fully discharge and recharge the battery at least once every 30

e recommend that you do not remove the battery yourself. If you do need
.g. long term storage) see “Removing the Battery” on page 6 - 3.

ew Battery
lways completely discharge, then fully charge, a new battery (see “Batte
ons on how to do this).

echarging the Battery with the AC/DC Adapter
he battery pack automatically recharges when the AC/DC adapter is attach
t. If the computer is powered on, and in use, it will take several hours to 
mputer is turned off but plugged into an electrical outlet, battery charge 
rs” on page 1 - 9 for information on the battery charge status, and to “B
r more information on how to maintain and properly recharge the battery
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D

r any circumstances
emperatures, it may explode

 to each other

arning

attery is bent out of shape after being
 notebook battery, shut your computer

 If the battery has been dropped we do
omputer continues to work with a dam-
, which may possibly result in fire. It is
ry every two years.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack unde
• DO NOT expose the battery to fire or high t
• DO NOT connect the metal terminals (+, -)

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery W

Should you notice any physical defects (e.g. the b
dropped), or any unusual smells emanating from the
down immediately and contact your service center.
not recommend using it any further, as even if the c
aged battery in place, it may cause circuit damage
recommended that you replace your computer batte
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D

B
H
U ry. Don’t turn off the computer even
if  up all of the battery power and shut
d

1
2  Never.
3 tings > Change advanced power 

 Battery
attery FAQ
ow do I completely discharge the battery?
se the computer with battery power until it shuts down due to a low batte
 a message indicates the battery is critically low, just let the computer use
own on its own.

. Save and close all files and applications.

. Create a power plan for discharging the battery and set all the options to

. Click Change plan settings (after creating it) and click Change plan set
settings.

Figure D - 18 - Create Power Plan - Discharge
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4
5

s - Battery
•
•
•
•
•

Battery Charging & 
Maintenance

How do I fully charge the battery?
When charging the battery, don’t stop
until the LED charging indicator light
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the
battery at least once every 30 days or
after about 20 partial discharges.
Windows 7 Information
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. Scroll down to Battery and click + to expand the battery options.

. Choose the options below (click Yes if a warning appears):

Figure D - 19 - Power Options Advanced Setting
Low battery levels = 0%
Critical battery Levels = 0%
Low battery action = Do Nothing
Critical battery action (On battery) = Shut Down
Critical battery action (Plugged in) = Do Nothing
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D
In
d
th
In
d
th
st

r installation order from Table D - 4 (the 
e installed in this order) which is the 
ted in the Drivers Installer menu 

he driver you wish to install, after 
driver it will become greyed out (if you 
ll any driver, click the Unlock button).
uctions for each individual driver 
edure as listed on the following pages.

- Drivers Installer Screen 2
river Installation
sert the Device Drivers & Utilities + User’s Manual

isc, click Install Drivers/Option Drivers (button) and
en click the appropriate driver name from the Drivers
staller menu. Follow the instructions to install the

river. Alternatively click Start, navigate (Browse..) to
e executable file and then follow the manual setup in-
ructions.

Figure 5 - Drivers Installer Screen 1

1. Check the drive
drivers must b
same as that lis
below.

2. Click to select t
installing each 
need to reinsta

3. Follow the instr
installation proc

Figure 6 
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D

nstalling Individual Drivers
ate/reinstall individual drivers it may

install the original driver.To do this go
nel in the Windows OS and double-
s and Features item (Programs >

am). If you see the individual driver
below), uninstall it, following the on
 may be necessary to restart the com-
appropriate section of the manual to
te/reinstall procedure for the driver in

 listed in the Programs and Features

 click Control Panel. 
stem (icon); System (icon) is in 

ecurity (category).
anager (in the left menu).
 device you wish to update/reinstall the 
ay need to click “+”).

date Driver button (check the Driver 
the on screen prompts.
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Table D - 4 - Driver Installation

Updating/Rei
If you wish to upd
be necessary to un
to the Control Pa
click the Program
Uninstall a progr
listed (if not see 
screen prompts (it
puter). Go to the 
complete the upda
question.

If the driver is not
item:
1. Click Start and
2. Double-click Sy

System and S
3. Click Device M
4. Double-click the

driver for (you m
5. Look for the Up

tab) and follow 

Windows 7 Drivers Page #

Chipset Page D - 35

Video Page D - 35

Audio Page D - 36

Modem Page D - 36

LAN Page D - 36

TouchPad Page D - 36

CardReader Page D - 36

Hot Key Page D - 36

Wireless LAN Module (Win 7) Page D - 37

PC Camera Module Page 7 - 26

3.75G/HSPA Module Page 7 - 37/Page 7 - 46

Fingerprint Reader Module Page 7 - 51
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D

ation Procedure
Drivers & Utilities + User’s Manual
tall Drivers (button).

ll Chipset Driver > Yes.
 Yes > Next > Next.
 to restart the computer.

ll Video Driver > Yes.
 Install (button).
press (or Custom if you prefer to 
figure the driver installation set-

 and click Next.
t (button) and click Yes.
.

Driver Install
Insert the Device 
disc and click Ins

Chipset
1. Click 1.Insta
2. Click Next >
3. Click Finish

Video
1. Click 2.Insta
2. Click Next >
3. Click the Ex

manually con
tings) button

4. Click Accep
5. Click Finish

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
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D

A
1
2
3

M
1
2
3

L
1
2
3
4

ll Touchpad Driver > Yes.

ton to accept the license, and then 

 > Restart Now to restart the com-

ll CardReader Driver > Yes.
.
.

ll Hotkey Driver > Yes. 
 Install.
 > Finish to restart the computer.
Windows 7 Information

- 36 Driver Installation

udio
. Click 3.Install Audio Driver > Yes. 
. Click Next.
. Click Finish to restart the computer.

odem
. Click 4.Install Modem Driver > Yes.
. Click OK.
. The modem is ready for dial-up configuration.

AN
. Click 5.Install LAN Driver > Yes.
. Click Install.
. Click Finish.
. The network settings can now be configured.

TouchPad
1. Click 6.Insta
2. Click Next.
3. Click the but

click Next.
4. Click Finish

puter.

CardReader
1. Click 7.Insta
2. Click Install
3. Click Finish

Hot Key
1. Click 8.Insta
2. Click Next >
3. Click Finish
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O
S
ce
ti
W
W
th
p

F

dule (Win 7)
ing system is the default setting for
l in Windows 7, and does not require
etooth Module (Win 7)” on page D
tion instructions.

Module (Win 7)
Windows 7 driver installation and
rmation in “Wireless LAN Module
D - 43.

dule
 Module” on page 7 - 25 for driver
nfiguration information.

odule
A Module” on page 7 - 33 for driver
nfiguration information.

ader Module (Win 7)
ion in “Fingerprint Reader Module
e D - 61, and check the installation
ptional Drivers
ee the pages indicated for the driver installation pro-
dures for any modules included in your purchase op-

on. Where Windows 7 information differs from
indows Vista it will be included in this chapter; if
indows 7 information is the same as Windows Vista
en refer to Chapter 7 as indicated on the following

age. 

igure D - 1 - Drivers Installer - Option Drivers Menu

Bluetooth Mo
Note: The operat
Bluetooth contro
a driver. See “Blu
- 38 for configura

Wireless LAN 
See the specific 
configuration info
(Win 7)” on page

PC Camera Mo
See “PC Camera
installation and co

3.75G/HSPA M
See “3.75G/HSP
installation and co

Fingerprint Re
See the introduct
(Win 7)” on pag
procedure.
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D

ntrol panel is used to configure the
ore does not require a driver. Use the
t Key Indicators” on page D - 5) to

the Bluetooth module is powered on,
ndicator will briefly be displayed.

ansfer

 and a Bluetooth enabled device is sup-
transfer is not supported). Therefore
etooth enabled device, you will not be

e to your computer until the file transfer

g From Sleep Mode

 resuming from the Sleep power-saving
on the Bluetooth module after the com-
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Bluetooth Module (Win 7)
The operating system’s Bluetooth Devices co
Bluetooth settings in Windows Vista, and theref
Fn + F12 key combination (see “Function/Ho
toggle power to the Bluetooth module. When 
the  LED will be orange and the on-screen i

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 6, on page 1 - 13/ Table 1
- 4, on page 1 - 9).

Bluetooth Data Tr

Note that the transfer of data between the computer
ported in one direction only (simultaneous data 
if you are copying a file from your computer to a Blu
able to copy a file from the Bluetooth enabled devic
process from the computer has been completed.

Bluetooth Module & Resumin

The Bluetooth module’s default state will be off after
state. Use the key combination (Fn + F12) to power 
puter resumes from Sleep.
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T
1
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3 s control

•
•

Add a Device

Click Start, and click
Control Panel and then
click Devices and
Printers (Hardware
and Sound). Click Add
a device to search for
any available Bluetooth
devices.

Figure D - 2
Bluetooth Devices & 

Click Icon Menu

 

Blue

luetooth Configuration in Windows 7
etup your Bluetooth Device so the Computer Can Find it
. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
. Make the device discoverable (to do this check your device documentatio

o Turn the Bluetooth Module On
. Press the Fn + F12 key combination to power on the Bluetooth module. 
. A Bluetooth icon  will appear in the taskbar.
. You can then do any of the following to access the Bluetooth Device

panel.

Double-click the taskbar icon  to access the Bluetooth Devices control panel.
Click/Right-click the taskbar icon  and choose an option from the menu.

Add a device

Right-Click Taskbar Icon



D

D

and click Add a device.
he computer.

you with a pairing code to be entered
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel 
2. Double-click the device you want to pair with t

3. On first connection the computer will provide 
onto the device.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure D - 3
Add a Device



Windows 7 Information

tooth Module (Win 7) D - 41

D

4 n-screen

5 ring. 
6 quired to

7

Figure D - 4
Pairing Code 

Example

Figure D - 5
Pairing Complete & 
Bluetooth Device 

Enabled

tion to
puters,
proce-
pairing
he on-
Blue

. Enter the code into your Bluetooth enabled device and follow any o
instructions to complete the pairing.

. Windows will check to see if any drivers are required to complete the pai

. Follow any on-screen instructions on the computer if device drivers are re
be installed.

. Click Close.

Pairing Codes

The example outlined here shows a connec
a mobile device. Other devices e.g. com
may have a slightly different connection 
dure, and may require you to confirm a 
code is correct on both devices. Follow t
screen instructions to complete the pairing.
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ice
ooth Devices.
and click Properties to:
new name and click OK).
heck box next to the service and click OK).

luetooth Devices
gs.
 Bluetooth devices to find this

nside it.
luetooth device wants to connect

it, if you want to be notified when a
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To Change Settings for the Bluetooth Dev
1. Click the taskbar icon and select Show Bluet
2. Right-click on the device you want to change 
• Change the name of the device (click Bluetooth, type a 
• Enable/Disable a service (click Services, clear/tick the c

To Make your Computer Discoverable to B
1. Click the taskbar icon and select Open Settin
2. Click Options, and make sure that Allow

computer check box (Discovery) has a tick i
3. Make sure that the Alert me when a new B

check box (Connections) has a tick inside 
Bluetooth device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure D - 6
Bluetooth Settings - 

Options
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Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 6, on
page 1 - 13/ Table 1 - 4, on
page 1 - 9).
Wireles

ireless LAN Module (Win 7)
 you have included an Intel® Wi-Fi Link 5300 Series (802.11 a/g/n), 3
02.11b/g or 3rd Party 802.11b/g/n WLAN module in your purchase opti
re that the Wireless LAN module is on before installing the driver.

se the Fn + F11 key combination (see “Function/Hot Key Indicators” on
3) to toggle power to the Wireless LAN module. When the WLAN modu
ed on, the  LED will be green and the indicator  will briefly be d
ake sure you install the drivers in the order indicated in Table 4 - 1, on pa

he standard driver installation procedure for the Intel® Wi-Fi Link 530
odule is outlined overleaf. If you want to include Intel® My WiFi Techn

art of the installation procedure, DO NOT install the driver as per the
ons overleaf, instead see “Intel® My WiFi Installation & Configura
age D - 48.

 you have installed the standard driver (as per the instructions overleaf) an
able Intel® My WiFi Technology at a later point you will need to rei

river (choose Unlock from the Drivers Installer menu). Follow the drive
on procedure and choose Modify from the menu when the option appears,
llow the remaining installation instructions in “Intel® My WiFi Insta
onfiguration” on page D - 48.
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/g/n) Driver Installation
” click Cancel to close the window.
 insert the Device Drivers & Utili-
D drive. 

click Next.

river Installation
 insert the Device Drivers & Utili-
D drive. 

Next.

g for Wireless LAN control in Win-
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Intel® Wi-Fi Link 5300 Series (802.11 a
If you see the message “Found New Hardware
1. Make sure the module is powered on, then

ties + User’s Manual disc into the CD/DV
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and 
6. Click Next > Next > Finish.

3rd Party 802.11b/g/n or 802.11b/g/n D
1. Make sure the module is powered on, then

ties + User’s Manual disc into the CD/DV
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click 
5. Click Next > Install.
6. Click Finish.
Note: The operating system is the default settin
dows 7 (see overleaf).

Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).
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llowing 

Network and 
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure D - 7
Click Taskbar Icon 
Menu & Network 

and Sharing Center
Wireles

onnecting to a Wireless Network
ake sure the Wireless LAN module is turned on.

. Click the taskbar wireless icon , and then double-click an access point 
nect to or click to Open Network and Sharing Center if you do not see a
you want to connect to in the taskbar menu (a list of options will appear a
setting changes, and creating a new network).
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access point to which you are trying to

 Work or Public).
rk and Sharing Center” to access
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2. You may need to enter a security key for any 
connect.

3. Click to select a network location (e.g. Home,
4. Click “View or change settings in Netwo

further options for the connection.
Figure D - 8

Network Location 
Set
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Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure D - 9
Click Taskbar Icon 
Menu - Disconnect
Wireles

. Click the taskbar icon  to see any currently connected networks.

. To disconnect from the wireless network you can click the taskbar wireles
click the active connection and then click Disconnect (button).
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meras, other computers, cell phones,
 to Bluetooth), while still connecting
ection. Intel® My WiFi Technology
nal area networks, and does not re-
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Intel® My WiFi Installation & Confi
Intel® My WiFi Technology uses your WLAN 
eight other WiFi enabled devices (e.g. digital ca
handheld devices etc.) to your computer (similar
to the Internet through your WiFi wireless conn
offers greater range and speed than other perso
quire an access point.

Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel
PROSet Wireless > Intel
My WiFi Technology), or
by clicking the taskbar
icon . Click the Help
icon  and select
a help topic from the
Contents menu.
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Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).

Figure D - 10
Intel(R) PRO Set
Intel(R) My WiFi 

Technology 
Installation
Wireles

tel® Wi-Fi Link 5300 Series My WiFi Driver Installation
 you see the message “Found New Hardware” click Cancel to close the
. Make sure the module is powered on, then insert the Device Driver

ities + User’s Manual disc into the CD/DVD drive. 
. Click Option Drivers (button).
. Click 1.Install WLAN Driver > Yes.
. Click Next > Next.
. Click the button to accept the license and click Next > Next.
. Click Custom (button) and click Next.
. Click Intel(R) My WiFi Technology (button) and select “This feat

be installed on local hard drive.”

. Click Next > Finish.
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tart menu (Start > Programs/All Pro-
iFi Technology).
 program there will be no connected
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Intel® My WiFi Configuration
You can configure the My WiFi settings as foll

1. Access the Intel® My WiFi Utility from the S
grams > Intel PROSet Wireless > Intel My W

2. Click Enable  (on the first run of the
devices listed).

Figure D - 11
Intel® My WiFi 

Utility



Windows 7 Information

s LAN Module (Win 7) D - 51

D

3 l Panel).
4
5

6

Figure D - 12
Network and 

Sharing Center

Figure D - 13
Intel WiFi STA 

Properties 
(Network 

Connections)
Wireles

. Click Start, and click Control Panel (or point to Settings and click Contro

. Click Network and Sharing Center (Network and Internet). 

. Click Change adapter settings. 

. Right-click Intel WiFi STA (Station) in Network Connections and select 
Properties.

Click Change Adapter
Settings 

Right-click Intel WiFi STA
(Station) and select Prop-
erties. 
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 network users to connect through

on your network that users can access
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7. Click Sharing (tab) and select “Allow other
this computer’s Internet connection”.

8. Click Settings to select any services running 
if required.

9. Click OK.

Figure D - 14
Intel WiFi STA 

Properties - 
Sharing

Click “Allow other
network users to
connect through
this computer’s In-
ternet connec-
tion”.

Click Settings to
select any Services
to be made availa-
ble to users if need-
ed.
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Figure D - 15
IP Address 

Warning

IP Addresses

The Intel® My WiFi de-
fault gateway IP ad-
dress is 192.168.0.1.
DO NOT use this ad-
dress for any Wireless
Access Point (or any
other static IP address
on your network).

Figure D - 16
Intel® My WiFi 

Utility
Wireles

0. A message will appear to inform you that the LAN adapter will be set to u
address 192.168.0.1.

. Click Yes to enable Internet Connection Sharing.

2. Access the Intel® My WiFi Utility from the Start menu (Start > Program
Programs > Intel PROSet Wireless > Intel My WiFi Technology).

3. Click Profiles .
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lick Edit.

Network Name to your personal
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14. Click Profiles, click Intel Wireless PAN and c

15. You can change the Profile Name and 
preferences in General (tab).

Figure D - 17
Profiles

Figure D - 18
Intel® My WiFi 

Profile Settings - 
General

Profile and Network Names

The Profile Name is the name as
displayed on your computer in the
Network Connections control pan-
el (see Figure D - 13 on page D -
51).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.
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Figure D - 19
Intel® My WiFi 

Profile Settings - 
Security
Wireles

6. Click Security (tab).
7. Change the Security Type to WEP and the Encryption Type to 64bit.
8. Enter a password (5 characters long) in the Passphrase box. 
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and DNS Server are Disabled. 
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19. Click Sharing (tab).
20. Make sure Filter Network Traffic and DHCP 

Figure D - 20
Intel® My WiFi 

Profile Settings - 
Sharing

Set Filter Network
Traffic & DHCP
and DNS Servers
to Disabled.
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Figure D - 21
Intel® My WiFi 

Profile Settings - 
Advanced
Wireles

1. Click Advanced (tab).
2. Make sure the Default Channel is set to Channel 1, 6 or 11.
3. Click OK to save all the settings and click Close to exit Profiles. 
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a Network) in Network Connections
apter settings).
tion Details.
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24. Double-click Intel My WiFi PAN (Personal Are
(Network and Sharing Center > Change ad

25. Click Details to display the Network Connec

Figure D - 22
Intel My WiFi PAN 

Network 
Connection Details 

(Network 
Connections)
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Figure D - 23
Intel® My WiFi 

Utility 
(Add New Device)
Wireles

6. Access the Intel® My WiFi Utility from the Start menu (Start > Program
Programs > Intel PROSet Wireless > Intel My WiFi Technology).

7. To add a new device follow the instructions in the devices’ user guide for 
connecting to a WiFi network.

8. Click Add New Device in Intel® My WiFi Utility to confirm the security s
detail.
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provides an easy point of access for
 and wireless device status etc.

 Settings and click Control Panel).
e PC).
k the icon  to access the network 
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Windows Mobility Center
The Windows Mobility Center control panel 
information on battery status, power plans used

To access the Windows Mobility Center:
1.Click Start, and click Control Panel (or point to
2.Double-click Windows Mobility Center (Mobil
3.Click the button to Turn wireless off/on, or clic
menu.

Figure D - 24
Windows Mobility 

Center
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Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 4.In-
stall FingerPrint Driver
>Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
Fingerprint R

ingerprint Reader Module (Win 7)
he fingerprint reader module provides a high level of security for your c
ake sure you have administrator’s rights to your computer, and have a 

assword enabled for full security protection.

efore beginning the enrollment process it is recommended that you go th
ngerprint tutorial. To run the tutorial click Start > Programs/All Program
ctor Suite QL > Fingerprint Tutorial after installing the driver.

ingerprint Reader Driver Installation
. Insert the Device Drivers & Utilities + User’s Manual disc into the

DVD drive.
. Click Option Drivers (button).
. Click 4.Install FingerPrint Driver > Yes.
. Click Software Installation.
. Click Next > Next > Next.
. Click Finish > Yes to restart the computer.
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grams > Protector Suite > Control 

d to click the Accept button to accept

will be prompted to do so (note: If you
not secure access to your computer).
rd.
erprints (you can click Tutorial to get
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User Enrollment
1. Click Start > Control Center (Start > All Pro

Center), or double click the taskbar icon .
2. On the first run of the program you will be aske

the license.
3. If you have not set a Windows password you 

have not set a password Protector Suite can
4. Click Submit when you have entered passwo
5. You will then be prompted to enroll your fing

help with fingerprint enrollment at any time).

Figure D - 25
Fingerprint 
Enrollment

Tutorial
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6 s for that

7
8  and then Fingerprint 

Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure D - 26
Fingerprints 

Enrolled
Fingerprint R

. Click the button above any of the fingers to begin the enrollment proces
finger.

. Swipe the finger until the progress bar reaches 100% to enroll that finger.

. Repeat the process for all the fingers you wish to enroll (see sidebar),
click the close  button to close the window.
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ntrol Center (and then swipe a finger)
plications, edit Settings and access
ntrol Center from the Start menu or
 All Programs menu.
ore information on any topic.
r video to get more information.

ther details.
 time you can access the Biomenu to
ess the Personal Safe, E-Wallet or
ntrol Center and access the Help
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9. Click the taskbar icon  and select Start Co
to allow you to Edit Fingerprints, register Ap
the Help menu etc. You can also run the Co
Protector Suite > Control Center item in the

10. Click “Help” in Control Center Home to get m
11. You can also run the Tutorial, or Product Tou

12. See “Help & Manual” on page D - 61 for fur
13. If you swipe your finger over the reader at any

lock the computer, register websites, acc
Strong Password Generator, open the Co
menu.

Figure D - 27
Fingerprint Control 
Center & Biomenu

Help
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Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
Fingerprint R

ingerprint Control Center Features

pplication Launcher
he Application Launcher allows you to register applications to be launch
signed to a particular finger. Simply copy the application icon on to one o
tered fingers and ten click OK to close the application window. Once regi
plication will launch when you swipe the appropriate finger across the s

assword Bank
he Password Bank stores registrations of user names, passwords and othe
r web sites etc. 

trong Password Generator
trong Password Generator helps you to create complicated passwords re
ictionary attacks from the Internet.

-Wallet
he E-Wallet provides biometric security for important personal informa
 credit card details, account numbers etc.
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